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Chapter 27: Mass Mover Tool

Mass Mover Tool 
What it does
With this tool you can select a region of your score (from a single note to the entire score) and edit 
all selected music at once. The Mass Mover Menu appears, containing all the commands you need 
to edit the selected music. For example, you can change any selected measures’ spacing, measure 
widths, layer assignments, stem directions, beaming patterns, and so on. You can also rebeam, 
rebar, transpose, or apply articulations to every note in any selected region.

The Mass Mover gets its name from the fact that it can also be used to copy music from one place 
to another—even from one Finale document to another. You can also use this tool for erasing 
selected musical elements from a region—such as articulations, chord symbols, lyrics, expres-
sions, MIDI controller data, and so on—without disturbing the other existing elements of the 
music in that region. See ERASING and COPYING MUSIC.

Note: You can undo any Mass Mover operation by choosing Undo from the Edit Menu. After 
extensive Mass Mover operations, however, you may discover that it takes a long time for Finale 
to catch up with you when you click a different tool. If so, you might want to turn the Undo fea-
ture off; to do so, choose Program Options from the Options Menu, Click Other, and deselect 
Allow Undo. See PROGRAM OPTIONS DIALOG BOX.

Special mouse clicks and keyboard shortcuts
• If Select Partial Measures is selected in the Edit Menu, double-click a measure to select 

it. If Select Partial Measures is off, a single click selects a measure.

• Double-click a selected measure to extend the selection to include the entire vertical measure 
“stack” (that measure in all staves). (If Select Partial Measures is turned on, the first double-
click selects a single full measure, and the second double-click selects the measure stack.)

• Drag-enclose a region to select it. If Select Partial Measures is turned on, drag diagonally 
across any region, large or small, to select it, even if it straddles a barline.

• Shift-click a measure (or a beat within a measure) to extend the selected region from the 
first region you selected.

• Click to the left of a staff to select an entire staff.

• Shift-click to the left of a staff to extend the selection from any other staves you’ve selected. 
You can also choose Select All from the Edit Menu to select the entire score.

• Drag a selected region so that it’s superimposed on the beginning of an unselected region 
to copy or move the selected music to the destination region. You specify which musical ele-
ments you want to move, as well as how you want them copied, from the Mass Mover Menu 
before you drag.
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• Ctrl–shift-click an unselected region to copy or move the specified contents of any selected 
music—no matter where it is in the score—to the point you clicked. You specify which musi-
cal elements you want to move, as well as how you want them copied, from the Mass Mover 
Menu before you click.

• Press ctrl while choosing Cut or Copy from the Edit Menu to display the Items to Clip dia-
log box; you’re in the process of creating a Clip File (a special kind of Finale document that’s 
named and saved separately from the original document). See ITEMS TO CLIP DIALOG BOX.

• Press ctrl while choosing Insert or Replace Entries from the Edit Menu to display the 
Paste dialog box from which you can select any Clip File you’ve already created (so that you 
can paste it into the current document). See ITEMS TO CLIP DIALOG BOX.

• Press shift while choosing Cut or Copy to display the Items to Clip dialog box, where you 
can specify which musical elements you want to cut or copy. You can also press shift and ctrl 
(see above) if you want to select only certain musical elements and create a Clip File. See 
ITEMS TO CLIP DIALOG BOX.

• Press delete to remove the selected music from the score, in all staves, so there are fewer mea-
sures remaining.

• Press backspace to erase the selected music, leaving behind only default rests.

• Press esc during a Mass Mover operation to cancel the operation and return control of the 
computer to you.

• Use the arrow keys to move selected measures into the previous and next systems. Staff Sys-
tems then are “locked” into specific groupings as if you had fit all the measures in that specific 
system. Locked systems will display an icon above and to the right. See MASS MOVER MENU, 
FIT MUSIC DIALOG BOX and UPDATE LAYOUT OPTIONS DIALOG BOX for more information on 
Fit Music Groupings.

• Type L to lock the selected systems. To unlock the selected systems type U. See MASS 
MOVER MENU for more detail on Locking and Unlocking systems.

Metatools
The Mass Mover Tool has a set of seven predefined and four programmable Metatools—one-key 
equivalents for longer Mass Mover procedures—that can save you time if you want to edit a 
selected region directly, without having to access dialog boxes or menus.

To program a Transposition Metatool
Click the Mass Mover Tool. Press shift and a number key (6-9). Finale displays the Transposition 
dialog box; set the transposition you want to program. Click OK.

To use a Mass Mover Metatool
To use a Mass Mover Metatool, select the measures you want to affect. Press the appropriate num-
ber key on your computer keyboard. The Mass Mover Metatools are defined as follows:
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Mass Mover Menu
How to get there

Click the Mass Mover Tool l.

What it does
The Mass Mover Menu is one of the most important menus in Finale. Its commands transform 
your music in many powerful ways; it’s called Mass Mover because it can make global changes to 
large selections of music at once. If you’ve told Finale you want to be able to select partial mea-
sures instead of only one-measure increments (by choosing Select Partial Measures from the Edit 
Menu), most of the Mass Mover commands work on selected regions as small as a single beat, or 
as large as the entire score. All the commands described below work on partial-measure selec-
tions, except as noted otherwise. The menu also contains commands for moving or copying music 
from one place to another. You can specify one of three ways to copy, and you can also specify 
which elements of the selected music you want copied—lyrics, chord symbols, articulations, 
notes, and so on.

In this menu, a check mark lets you know which action and which elements are currently selected. 
The Mass Mover Menu remembers your settings, even when you choose another tool and later 
return to the Mass Mover Tool.

Metatool Predefined effects

1 Implode Music (displays the Implode Music dialog box)

I (letter) Drag-Implode Music for multiple staves (displays the Implode Music dialog box)

2 Explode Music for multiple staves (displays the Explode Music dialog box)

E Drag-Explode Music (displays the Explode Music dialog box)

3 Respace notes, lyrics, and accidentals (Apply Beat Spacing command) using the 
settings in the Music Spacing Options dialog box

4 Respace notes, lyrics, and accidentals (Apply Note Spacing command) using the 
settings in the Music Spacing Options dialog box

5 Show elapsed time based on current tempo (displays the Elapsed Time dialog box)

6-9 Transpose (programmable)
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• Copy and Replace. In this copying mode, Finale copies music (or selected musical elements) 
from the selected (“source”) measures and replaces the entries in the “target” measures.

To use this function, select a region of music; then drag the selected area so that it’s superim-
posed on the beginning of the destination area. If Select Partial Measures is selected in the 
Edit Menu, drag to the location of the precise beat where you want the material to be pasted; 
otherwise, drag to any point in the first measure of the destination region. (If the target mea-
sure is offscreen, ctrl–shift-click it.) Finale copies the specified musical elements of the source 
music to the target location, replacing that element of the music that’s already there. Even if 
the selected measure is an empty measure, it will replace the target measure.
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Suppose, for example, that there are staccato marks over every note in measure 1, and accent 
marks over every note in measure 2. If, using the Copy Entry Items command in the Mass 
Mover Menu, you specify that Finale should copy only articulations, drag measure 1 on top of 
measure 2 to copy the staccato marks from measure 1 (replacing the accent marks).

• Copy and Insert. In this copying mode, Finale inserts a copy of the selected music just before 
the target measure. This command only works if you’ve specified that you want to copy notes 
(by choosing Copy Entry Items from the Mass Mover Menu); you can’t insert any other items 
by themselves.
To use this function, select a region of music, then drag the selected region so that it’s super-
imposed on the beginning of the destination area. If Select Partial Measures is selected in the 
Edit Menu, drag to the location of the precise beat where you want the material to be inserted; 
otherwise, drag to the measure before which you want the material inserted. (If the target mea-
sure is offscreen, ctrl–shift-click it.) Finale inserts a copy of the source material just before the 
beat or measure at which you release the mouse button. Note that Finale will automatically 
create enough new measures (in all staves) to accommodate the copied material, or rebar the 
piece as necessary.

• Mirror. In this copying mode, the copy you create is an intelligent copy (a mirror) of the 
source measure or measures. If you edit the notes or expression markings in the source mea-
sures, the change is immediately reflected in the mirrored measures. To guarantee the mea-
sures stay identical, you are unable to edit or copy anything into a measure which has a mirror 
applied to it. When you no longer want the measures to be mirrored, remove the function with 
the Convert Mirrors command in the Mass Mover Menu. See CONVERT MIRRORS.
The process is exactly the same as any Mass Mover copying action: Select a source region of 
complete measures. Drag the first selected measure so that it’s superimposed on the first target 
measure (or, if the target measure is offscreen, ctrl–shift-click it). Finale displays the Mirror 
Attributes dialog box, letting you specify a transposition, if you want, and other aspects of the 
copy. (See MIRROR ATTRIBUTES DIALOG BOX.)
You can only create this kind of copy if the target measures are originally empty. Note also 
that you can’t deselect Copy Everything in the Mass Mover Menu if you’re creating a mirror; 
everything in the source measures will be copied to the target measures. (You can, however, 
tell Finale not to display certain elements of the music by specifying them in the Don’t Draw 
section of the Mirror Attributes dialog box that appears).
The result is a copy that’s dynamically linked to the source measures. If you change any 
aspect of the source measures, the mirror automatically changes too. You can change any set-
tings you made in the Mirror Attributes dialog box as follows: click the Mirror Tool, then 
shift-click any mirror (identified by a mirror icon). Note, too, that you can copy a mirrored 
measure in the usual way; if you’ve selected Mirror from the Mass Mover Menu, the target 
measures will themselves be a mirror (of the mirror). If you’ve selected Copy and Replace or 
Copy and Insert, however, the mirror you’re copying will be turned into normal non-mirrored 
music.

• Clear Entries and Smart Shapes. When you choose Clear Entries and Smart Shapes, Finale 
removes the contents of the selected music (whether or not you’ve selected entire measures), 
leaving equivalent rests behind. (This command performs the same function as highlighting 
measures and pressing the Backspace key.)
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• Clear Items. Choose Clear Items to display the Clear Items dialog box, which lets you spec-
ify either Measure or Entry (note-related) items to erase. Either selection displays another dia-
log box (see MEASURE ITEMS DIALOG BOX or ENTRY ITEMS DIALOG BOX), listing every 
possible erasable item. Choose any items you want to erase. See CLEAR ITEMS DIALOG BOX.

• Copy Everything. The bottom half of the Mass Mover Menu lets you specify which elements 
of the selected music you want copied. If there’s a check mark beside Copy Everything, Finale 
assumes you intend to copy every element of the selected music—notes, markings, chord 
symbols, lyrics, changes in note size, stem and beam alterations, measure widths, key signa-
tures, and so on. To specify only certain of these elements, choose either Copy Entry Items or 
Copy Measure Items.

• Copy Entry Items. An entry is a note or rest; an entry item is anything attached to it: lyrics, 
articulations, chord symbols, and so on. When you select this item, a dialog box appears, list-
ing entry items that you can select for copying. Your Mass Mover copying actions will only 
copy the selected items. For a complete list, see ENTRY ITEMS DIALOG BOX.

• Copy Measure Items. When you choose this command, Finale displays the Measure Items 
dialog box, listing various measure-related elements (Smart Shapes, measure widths, MIDI 
data, and so on) that you can select for copying. For a complete list that includes descriptions 
of these elements, see MEASURE ITEMS DIALOG BOX. When this item is selected, your Mass 
Mover copying actions will only copy the selected items.

• Set SmartFind Source Region. To use this command, select a region of music with the artic-
ulations, slurs or other markings that you like. The selection may include a partial measure. 
Note that the region must occur on a single staff, not spanning multiple staves. Only rhythms 
and markings in the current layer of the source region are used for the pattern matching and 
painting process. From the Mass Mover Menu, choose Set SmartFind Source Region. Next, 
use the Apply SmartFind and Paint to copy or “paint” the markings onto notes of the same 
rhythmic pattern. Patterns in all layers of the target region are considered for matches.

• Deselect SmartFind Source Region. If you’ve selected the wrong region, or wish to change 
the region to a new source, select the Deselect SmartFind Source Region command.

• Apply SmartFind and Paint. Choose this menu item to display the SmartFind and Paint dia-
log box where you can select the types of markings to paint from the source region onto rhyth-
mically identical target regions. See SMARTFIND AND PAINT DIALOG BOX.

• Change: Articulation Assignments • Chord Assignments • Note Expression Assignments 
• Ties • Tuplets • Note Durations • Note Heads • Note Size. Using the commands in this sub-
menu, you can change certain aspects of a selected region all at once—make all the notes 
smaller, all the ties over notes, and so on.

Choose Articulation Assignments or Note Expression Assignments to adjust the positions 
of all (or certain) articulations or note expressions in a region. You can also use these com-
mands to swap one symbol for another. See CHANGE ARTICULATION ASSIGNMENTS DIALOG 
BOX and CHANGE NOTE EXPRESSION ASSIGNMENT DIALOG BOX.

Similarly, choose Chord Assignments to display a dialog box that lets you change the visual 
display or playback attributes of chord symbols in the selected region; see CHANGE CHORD 
ASSIGNMENTS DIALOG BOX.
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Choose Ties or Tuplets to change to settings of ties or tuplets over a selected region. The 
Change Tuplets dialog box settings are the same as the Tuplet Definition dialog box. See 
CHANGE TIES DIALOG BOX and TUPLET DEFINITION DIALOG BOX.

Using the Note Durations command, you can halve or double the note values in a selected 
region, in effect re-notating the same passage to last twice (or half) as long. Finale will even 
rebar the affected passage, if you wish, to place the correct number of notes in each affected 
measure. See CHANGE NOTE DURATIONS DIALOG BOX.

Finally, use Note Size to change the size of the notes in the selected region—to create cue 
notes, for example. See CHANGE NOTE SIZE DIALOG BOX. Or, use Note Heads to change the 
size of the head of the note, leaving the stems and flags their original size. See CHANGE NOTE-

HEADS DIALOG BOX.

• Music Spacing: Apply Beat Spacing • Apply Note Spacing • Apply Time Signature Spac-
ing. These commands, which affect full-measure selections are unique to Finale. They let you 
space the notes and measures of your score the same way a professional engraver does—by 
consulting a table of width values for each note, and spacing the notes and measures accord-
ingly. The result is nonproportional spacing, where a whole note isn’t allotted four times as 
much width as a quarter note—it’s actually allotted much less space. See MUSIC SPACING.

If you Apply Beat Spacing (Metatool 3) to the selected music, Finale calculates the position 
of each beat in the measure according to the ratio or table of widths; any notes within the beat 
are spaced linearly (where an eighth note gets exactly half as much space as a quarter note, 
and so on). Choose Apply Note Spacing (Metatool 4) if you want Finale to calculate the pre-
cise position of each note based on its ratio or the table of widths. This command provides 
more exact spacing than does the Beat Spacing command; both result in a striking, beautifully 
laid-out score. Finale uses Note Spacing when Automatic Music Spacing is being used.

You can also choose Apply Time Signature Spacing, which restores notes to linear spacing, 
where a half note gets exactly twice as much space as a quarter note. Time Signature Spacing 
is what Finale uses when you first put notes into the score when Automatic Music Spacing is 
not being used. Because Time Signature Spacing is linear, the Collision Avoidance options in 
Music Spacing Options are ignored.

& Ï Ï Ï Ï Ï Ï Ï Ï Ï Ï Ï Ï Ï Ï Ï

& Ï Ï Ï Ï Ï Ï Ï Ï Ï Ï Ï Ï Ï Ï Ï
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This example is spaced with Beat 
Spacing. Each beat is spaced 
non-linearly first, then spaced within 
the beat linearly.

This example is spaced with Note 
Spacing. Each note is spaced 
non-linearly.

This example is spaced with Time 
Signature Spacing. Each note is spaced 
linearly.
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Keep in mind that you can use any of these three music-spacing methods on any measures in 
your score, mixing and matching as necessary. You can also experiment with a certain selected 
region, trying first one kind of music spacing and then another; only the most recently-applied 
spacing will remain. All three music-spacing commands respect the preferences you establish 
by choosing Music Spacing Options and making changes in the subsequent dialog box, 
including collision avoidance. See MUSIC SPACING OPTIONS DIALOG BOX.

• Rebar: Rebar Music • Rebar Options. Finale’s Rebar command is useful after you insert or 
delete notes, halve or double note values, and so on. The command automatically re-distrib-
utes the notes of your piece so that each measure contains the correct number of beats, accord-
ing to the time signature. (Finale automatically rebars the piece each time you change the time 
signature, unless you turn off this option in the Time Signature dialog box.) When you rebar a 
region that contains partly-filled measures, Finale does not “pad” the measures with rests. If a 
measure contains two quarter notes (and no rests) in each of two measures, and you rebar the 
music, you’ll end up with one measure containing four quarter notes. (You must enter the rests 
to maintain their positions.)

Choose Rebar Options to display the Rebar Options dialog box, where you can decide how 
far Finale should go with its rebarring: all the way to the end of the piece, only through the 
next empty measure, and so on. Once you’ve established your preferences in this way, select a 
region and choose Rebar Music, so Finale actually perform the rebarring. If the results aren’t 
what you expected, choose Undo from the Edit Menu, change your Rebar Options, and try the 
command again. See REBAR OPTIONS DIALOG BOX.

• Rebeam: Rebeam Music • Rebeam to Time Signature • Rebeam to Lyrics. When you enter 
notes into Finale, it beams eighth notes (and smaller values) automatically, according to the time sig-
nature.

Using the Rebeam commands, however, you can change the beaming patterns for notes 
you’ve already added to the score. Rebeam Music simply restores beaming to the patterns 
dictated by the time signature; you’d use this command after manually changing the beaming. 
Rebeam to Time Signature, on the other hand, lets you rebeam the selected music into any 
beaming pattern you wish, even if it’s unrelated to the time signature. Finale displays a variant 
of the standard Time Signature dialog box, where (by changing the “beaming signature”) you 
specify any beaming pattern you can dream up. See TIME SIGNATURE DIALOG BOX for details 
on how the Time Signature controls affect beaming.

Beaming to lyrics is a convention used in opera or art song notation. In this scheme, eighth, 
sixteenth, and shorter notes are never beamed together in the vocal line except when a syllable 
is sustained through more than one note (melisma). Choose Rebeam to Lyrics to display the 
Lyric Rebeaming dialog box, in which you can specify the lyrics you want rebeamed in this 
way. See REBEAM TO LYRICS DIALOG BOX.

• Utilities: Check Accidentals • Check Elapsed Time • Check Ties • Convert Mirrors • 
Explode Music • Fill With Rests • Freeze Stems Down • Freeze Stems Up • Implode 
Music • Remove Manual Slur Adjustments • Remove Stem Changes • Respell Notes. The 
Utilities command offers a selection of miscellaneous transformation commands.
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Check Accidentals tells Finale to sweep through the selected region and hide any accidentals 
on notes tied over from the end of the previous measure, as shown below, and to add acciden-
tals, if necessary, on subsequent notes in the measure. You should run Check Ties *before* 
running Check Accidentals.

Check Elapsed Time (Metatool 5) displays the Elapsed Time dialog box. When you select a 
region of music this dialog box displays the real-time length of the selected region of music 
based on the currently defined tempo. See ELAPSED TIME DIALOG BOX. 

The Check Ties command corrects the playback of ties in a selected region. When you first 
put ties into the score using the Simple Entry or Speedy Entry tools, they sometimes don’t 
play back correctly. For example, the ending tied note may be attacked again instead of being 
added to the duration of the note to which it’s tied; furthermore, when a tie straddles a system 
line break, the tie sometimes isn’t continued onto the next system. This command corrects 
these problems.

The Convert Mirrors command affects Mirrors, or “intelligent copies” of certain measures, 
in which the copies are dynamically linked to the source music. It converts such measures into 
“real” measures—in effect, severing the link to the original source measures, and changing the 
selected mirror measures into normal non-mirrors. A dialog box appears asking you if you’re 
sure you want to convert them.

Finale’s Explode Music (Metatool 2 & E) command strips a chordal passage into individual 
single-line melodies on separate staves. You could use this feature, for example, to transform a 
piano reduction into four monophonic-melody staves for a choir. You’re not limited to explod-
ing a single staff; you can select several staves for exploding. (Explode Music and Implode 
Music only affect full-measure selections.)

After selecting the region you want to explode, choose this command. The Explode Music 
dialog box appears, where you can tell Finale how many resultant staves you want, what clefs 
they should use, and so on. See EXPLODE MUSIC DIALOG BOX.

Fill With Rests checks a selected region of music for rhythmically incomplete measures and 
automatically fills them with the correct number of rests, saving you the time-consuming task 
of checking measures yourself (perhaps inaccurately). Fill With Rests works on full measures, 
not partial measures. However, if you select a region that contains a partial measure, Finale 
will warn you in advance that the full measure will be filled with rests. You can choose to con-
tinue or to cancel the Fill With Rests request. Note that this command will not affect com-
pletely empty measures (measures with default rests). You can use the “Change to Real Whole 
Rests” Plug-in to do that. See CHANGE TO REAL WHOLE RESTS. Also, if you have selected 
Allow Dotted Rests in More Quantization Settings dialog box, Finale will use dotted rests. For 
example, three eighth rests will become a dotted quarter rest.

By choosing Freeze Stems Up or Freeze Stems Down you can manually flip a region of 
stems up or down. Finale normally decides whether a note’s stem should go up or down 
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depending on its vertical position in the staff. If you’ve specified a multiple-voice arrange-
ment—for example, upper voice = stems up, lower voice = stems down—using the Layer 
Options command (Options Menu), Finale again chooses stem directions automatically. To 
restore such “frozen” stems to stems that can flip depending on the notes’ pitches, select the 
region and choose Remove Stem Changes. This command also removes any Reverse, Dou-
ble, or Split Stem editing you’ve done with Special Tools.

When you Implode Music (Metatool 1 & I), Finale condenses the music on the selected 
staves onto a single staff. This command displays a dialog box in which you can specify how 
you want Finale to implode the music. You’re not limited to exploding a single staff; you can 
select several staves for imploding. (Explode Music and Implode Music only affect full-mea-
sure selections.) There is also a piano reduction Plug-in which requires fewer steps and pro-
vides more control. See PIANO REDUCTION. See IMPLODE MUSIC DIALOG BOX.

When you Remove Manual Slur Adjustments, Finale resets any SmartShape slurs to their 
default positions. Engraver slurs will reshape independently again. See SLURS.

When you choose Respell Notes, Finale retranscribes the pitches of the selected notes, so they 
appear as they would when entered for the first time. For example, if a region contains C dou-
ble sharps, this command will change all of them to D naturals. The Respell notes command 
respells using the setting in the Enharmonics submenu.

• Apply Articulation. This powerful command lets you add a certain articulation mark (a stac-
cato, for example) to every note in a selected region at once. See APPLY ARTICULATION DIA-

LOG BOX.

• Move Layers. This command provides a way to move music from one of Finale’s transparent 
staff layers to another. You can even swap the music between layers—if, for example, you 
mistakenly entered several stems-down notes in Layer 1, which you intended to use only for 
stems-up (upper) voices. See MOVE LAYERS DIALOG BOX for details; this command only 
affects full-measure selections.

• Retranscribe. Choose this command to retranscribe the selected region using the quantization 
settings in the Quantization Settings dialog box. See QUANTIZATION SETTINGS DIALOG BOX 
and RETRANSCRIPTION.

Note: When retranscribing, Finale will not change any of the MIDI information in the region. 
It will, however, remove any markings that were entered in the music.

• Transpose. (Metatools 6-9) Choose this command to display the Transposition dialog box, 
which lets you specify how you want the selected music transposed—up an octave, down a 
third, or whatever interval you specify. See TRANSPOSITION DIALOG BOX.

• Lock Systems • Unlock Systems. Choose these options to lock the selected systems against 
reflowing after choosing Update Layout from the Edit Menu. Both the measure grouping and 
the contents of the measure are locked. The system locks appear as icons ç on the upper 
right side of the staff. You can turn the display of these icons on and off using the View Menu 
command Show Page Layout Icons. See VIEW MENU.

• Fit Music. This command, only available in Page View, is extremely useful in laying out the 
measures of your piece—avoiding awkward page turns, placing 4 bars on a line, and so on. 
You can also specify a number of measures-per-line you want for the selected region. See FIT 
MUSIC DIALOG BOX for details. (This command only affects full-measure selections.)
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Copy Measures dialog box

How to get there

Click the Mass Mover Tool l (and make sure Select Partial Measures isn’t selected in the Edit 

Menu), and select a region of measures. Drag the first selected measure so that it’s superimposed 
on the first target (destination) measure, or ctrl–shift-click the target measure (as long as the target 
measure isn’t directly above or below the selected measure).

What it does
When you copy music, Finale offers you the chance to create multiple copies, placed one after 
another. For example, if you want a one-measure bass figure to repeat three times, you need only 
enter it once (in the first measure); then you can use the Mass Mover to copy it into the second 
measure. This dialog box appears, asking how many times you want it copied; enter 3 and click 
OK. Finale will copy the selected measure into measures 2, 3, and 4.

• How many times? In this text box, enter the number of times you want the selected music 
copied. If you enter a number higher than 1, Finale will place the additional copies after the 
first copy, on the same set of staves.

• OK • Cancel. Click OK (or press enter) to proceed with, or Cancel to abort, the copying pro-
cess. You return to the score.

Entry Items dialog box
How to get there

Click the Mass Mover Tool l, and select a region of measures. If you’re about to copy or 

move an element of the music, choose Copy Entry Items from the Mass Mover Menu. If you’re 
about to erase an element of the music, choose Clear Items from the Mass Mover Menu (the Clear 
Items dialog box appears); click Only Selected Items, and then click Entries.

Or, when you’re cutting or copying music from the score, press shift while choosing Cut or Copy 
from the Edit Menu. The Items to Clip dialog box appears; deselect Entry Items, then click it 
again.
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What it does
You can copy or erase any element of your music without disturbing the remaining elements. 
These fall into two broad categories: Entry Items, or note-related markings (lyric syllables, chord 
symbols, articulations, and so on) and Measure Items, or measure-related markings and vari-
ables. Entry Items are listed in this dialog box. For example, you might want to erase only the lyr-
ics from a selected region (while keeping the notes); or you might want to copy chord symbols or 
articulations from one place to another (without changing or moving the notes). This dialog box 
lets you specify which elements you want to copy or erase.

• Entries. If you’re copying the selected music by dragging it, Entries means notes and rests 
alone, including their spacing. 

If you’re copying, the Entry Modifications dialog box appears when you click this checkbox, 
letting you specify changes you want made to the selected music in the process of copying. For 
example, you could copy a musical passage from one location to another, but specify that the 
copy be transposed. See ENTRY MODIFICATIONS DIALOG BOX.

If you’re erasing, clicking Entries is the same as selecting all entry-related items (notes, lyrics, 
chord symbols, and so on) from the selected region (because those items can’t exist unless 
there are notes they can be attached to).

• Articulations. Select this item to move or copy all articulation markings (staccatos, accents, 
and so on) created with the Articulation Tool. See ARTICULATION TOOL for more information 
on Articulations.

• Chords. This item governs chord symbols (and fretboard diagrams, if any) you created with 
the Chord Tool. If you’re copying chord symbols from one passage to a passage in a different 
key, Finale transposes the chord symbols automatically. See CHORD TOOL for more informa-
tion on Chord symbols.



Entry Items dialog box 27-13      

OC

OC

ndex

Index

ext 
hapter

ext 
hapter

revious
hapter

revious
hapter
T

T

I

N
C

N
C

P
C

P
C

• Lyrics. Select this item to copy or erase lyrics you created with the Lyrics Tool. See LYRICS 
TOOL for more information on Lyrics.

• Note Expressions. This element includes all note expression marks you’ve created with the 
Expression Tool. See EXPRESSION TOOL for more information on expressions.

• Smart Shapes (Assigned to Notes). This checkbox allows you to select note-attached slurs or 
bends for copying and erasing.

• Notehead and Percentage Alterations. This item includes any reductions or enlargements 
you’ve performed on notes or note groups with the Resize Tool, as well as adjustments you’ve 
made to the positions of notes or accidentals with the Special Tools Tool. If you’ve created a 
measure of cue notes, for example, you’d select this checkbox to copy onto other measures so 
that their notes are reduced equally. See RESIZE TOOL and SPECIAL TOOLS TOOL.

• Performance Data. When you record a real-time performance or sequence (using the Tran-
scription Mode of HyperScribe), Finale gives you the option of saving certain MIDI informa-
tion that make the performance sound human. This performance data includes the velocity 
information (how hard you struck each key) as well as minor rhythmic deviations from the 
beat (Start and Stop Time data).
After you’ve transcribed a performance, you can tell Finale to play back the notation and the 
captured performance data, giving the playback a very human “feel” (as opposed to the very 
precise but “square” sound Finale produces when it reads only the notation). If you select Per-
formance Data in this dialog box, therefore, you can actually copy this “feel” information onto 
other passages in your score (or erase it altogether).
You can use the MIDI Tool to copy or erase only specific elements of performance data—for 
example, only the key velocity data, or only the Start and Stop Time information. See TRAN-

SCRIPTION MODE, KEY VELOCITY and START AND STOP TIMES.

• Tuplet Definitions. This element is only available when you’re erasing; it specifies that tuplet 
definitions created with the Tuplet Tool will be erased from any tuplets in the selected region. 
In other words, if you select it, Finale will turn all tuplets (triplets, quintuplets, and so on) into 
normal non-tuplet notes (even if the result is too many beats in the measures). See TUPLETS 
for more information on tuplets.

• Beam Extensions • Secondary Beam Breaks. These elements refer to beaming changes 
you’ve made with the Special Tools Tool (the Beam Extension and Secondary Beam Break 
tools). The significance of these and other elements in this dialog box pertaining to beaming is 
that you need only create such special beaming once—in the first measure. Then you can use 
this dialog box to copy only the beam modifications to other measures; even if the notes are 
different, they’ll receive the same custom beaming as the source measure. See SPECIAL TOOLS 
TOOL.

• Stem and Beam Alterations. This element refers to custom stemming and beaming you’ve 
created with the Special Tools Tool. It includes any changes you’ve made with the Stem 
Length, Custom Stem, Broken Beam, Beam Angle, and Secondary Beam Angle tools. See 
SPECIAL TOOLS TOOL.

• Dot and Tie Alterations. Special Alterations include any changes you’ve made with the Tie 
or Dot tools in the Special Tools Tool. See SPECIAL TOOLS TOOL.
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• Entries in Other Staves. This element refers to cross-staff notes (notes that have been moved, 
for clarity, to another staff with the Note Mover Tool, even though they still “belong” to their 
original staff). If you don’t select Entries in Other Staves, Finale still copies all notes in the 
selected region; the difference is that the resultant copy will return the cross-staff notes to their 
original staff. See NOTE MOVER TOOL.

• Clefs. Use the Clefs checkbox to determine whether to include the starting clef and any clef 
changes in the selected region for copying.

Note that clefs will not copy by default when you drag-copy full measures. This checkbox 
does not affect partial measure copies, which continue to not copy the clef.

• All • None. Click All to select all of the checkboxes at once, or None to deselect all of them.

• OK • Cancel. Click OK (or press enter) to confirm the settings you’ve made in this dialog box 
and continue with the erasing or copying operation. Click Cancel if you decide not to specify 
any of these elements. You return to the score (or previous dialog box).

Entry Modifications dialog box
How to get there

Click the Mass Mover Tool l, and select a region of measures. If you’re about to copy or 

move an element of the music, choose Copy Entry Items from the Mass Mover Menu. After the 
Entry Items dialog box appears click Entries.

Or, when you’re cutting or copying music from the score, press shift while choosing Cut or Copy 
from the Edit Menu. The Items to Clip dialog box appears; deselect Entry Items, then click it 

again. Click the Mass Mover Tool l, and select a region of measures. After the Entry Items 

dialog box appears click Entries.

What it does
This dialog box lets you modify the music you’re copying in a number of useful ways. For exam-
ple, you can transpose the copy, rebeam its beamed notes into new patterns, or freeze all of its 
stems up or down.
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• Check Accidentals. If this box is selected, Finale will inspect the usage of accidentals in the 
copied music, making sure that any note tied over from a previous measure doesn’t show an 
accidental, but that a recurrence of that note (if it is a non-diatonic note) later in the measure 
does. It’s the equivalent of the Check Accidentals command (see MASS MOVER MENU).

• Freeze Stems • Up • Down. When you select Freeze Stems, the Up and Down buttons become 
available; click one to “freeze” all stems in the copied passage in the same direction.

• Reanalyze Harmonics. This option tells Finale to restore any chromatic notes to their default 
enharmonic “spellings” (if you’ve edited them) when it creates the copy.

• Rebeam. When you click this box, the Rebeam to Time Signature dialog box appears, in 
which you can specify a new beaming pattern for the eighth notes (and smaller values) in the 
copied material. See BEAMING for details on beaming patterns.

• Remove Reverse, Split, Double and Freeze Stemming. Select this option if, in the process 
of copying music, you want to remove any special stemming you created with the Reverse 
Stem, Double/Split Stem, and Freeze Stem tools of the Special Tools Tool. This option 
restores all stem directions to “floating” status, so that they can flip up or down depending on 
their staff location.

• Transpose. When you click this checkbox, the Transposition dialog box appears, where you 
can specify a transposition for the copied material. See TRANSPOSITION DIALOG BOX.

• OK • Cancel. Click OK (or press enter) to proceed with the music copying, or Cancel to aban-
don it.

Measure Items dialog box
How to get there

Click the Mass Mover Tool l, and select a region of measures. If you want to erase only mea-

sure items, choose Clear Items from the Mass Mover Menu, click Only Selected Items, then click 
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Measures. If you want to copy only measure items, choose Copy Measure Items from the Mass 
Mover Menu.

What it does
When you copy or delete musical material from a selected region, Finale lets you select the spe-
cific elements of the selected music you want to copy (or erase). These fall into two broad catego-
ries: Entry Items, or note-related markings (lyric syllables, chord symbols, articulations, and so 
on) and Measure Items, or measure-related markings and variables. Measure Items are listed in 
this dialog box, although certain items are available only for specific actions. (If you select only 
part of a measure before choosing Clear Items, the Measure Items choice won’t be available in the 
dialog box.) Select the desired items (as many as needed) to copy, clear, or edit.

Measure Item What it includes

Continuous Data (Copy or Erase) MIDI controller data (pedaling, channel pressure, and so on) and pitch wheel data 
you’ve captured from a performance in Transcription Mode by clicking Save Continuous Data. 
Also any editing you’ve done to this data with the MIDI Tool.
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• Select All • Select None. Click the appropriate box to check all of the boxes or clear all of the 
boxes.

• OK • Cancel. Once you’ve selected those items you want to copy or erase, click OK (or press 
enter) to exit the dialog box and proceed with the process. Click Cancel if you decide not to 
copy or erase anything.

Copy Positioning dialog box
How to get there

Select a region with the Mass Mover Tool l. From the Mass Mover Menu, choose Copy Mea-

sure Items. From the Measure Items box that appears, select Measure Positioning.

Graphics (Assigned to 
Measures)

(Copy or Erase) Graphics you’ve attached to measures, in Scroll View Only, with the Graphics 
Tool.

Key Signatures (Copy only) Any key changes you’ve created with the Key Signature Tool.

Measure Number Enclo-
sures

(Copy only) Any occurrences (in a region for which you’ve specified measure numbers with a 
geometric enclosure on Selected Numbers) where you’ve added, deleted, or resized the enclosures 
with the Measure Tool.

Measure Positioning (Copy only with Automatic Music Spacing off) The music spacing you’ve specified by using the 
Music Spacing commands, or by dragging the handles of individual measures’ beat charts (see 
BEAT POSITIONS). When you click this item, the Copy Positioning dialog box appears, where you 
can tell Finale how, or if, you want to change the positioning of the copy you’re creating.

Measure Widths (Copy only) The barline-to-barline widths of a region of source measures. When you click this 
item, the Copy Measure Width dialog box appears, where you can tell Finale how, or if, you want 
to change the measure width of the copy you’re creating.

Ossia (Assigned to Mea-
sures)

(Copy or Erase) Floating measures you’ve attached to measures, in Scroll View only, with the 
Ossia Tool.

Repeats (Copy or Erase) Repeat barlines or text repeats (such as “To Coda”) created with the Repeat Tool.

Measure Expressions (Copy or Erase) Expression markings you’ve created with the Expression Tool: dynamics, 
rehearsal marks, and so on.

Smart Shapes (Assigned 
to measures)

(Copy or Erase) The intelligent, stretchable expression markings created with the Smart Shape 
Tool: slurs, brackets, crescendos, and so on.

Split Points (Copy or Erase) Any measure “split points”—places you’ve specified as permissible breaking 
points in a long measure that might straddle a system break. (You create split points with the Mea-
sure Tool.)

Staff Styles (Copy or Erase) Any Staff Style defined as “copyable” in the Staff Style dialog box. Erase any 
Staff Style in the selected region.

Tempo Changes (Copy or Erase) Tempo changes captured from a Transcription Mode performance, or edited by 
the Tempo Tool.

Text Blocks (Assigned to 
Measures)

(Copy or Erase) Text blocks you’ve attached to measures with the Text Tool.

Time Signatures (Copy only) Any meter changes you’ve created with the Time Signature Tool.

Measure Item What it includes
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What it does
When you’re about to copy only certain elements of a selected region to another region—specifi-
cally Measure Positioning—you can use this dialog box to specify that certain changes be made to 
the resultant copy. To copy Positioning, Automatic Music Spacing must be turned off in the Edit 
Menu.

• Position Notes: No Change • According to the Time Signature • Manually (by Dragging). 
If the No Change radio button is selected, the copying process you’re about to perform won’t 
affect the Measure Positioning mode (as determined by the measure attributes for the selected 
measures). You’re simply telling Finale to copy these elements to a target region exactly as 
they appear in the source region. (This item has no effect unless you’re in the process of copy-
ing a selected region.)
If the According to the Time Signature radio button is selected, Finale copies the measure, 
but uses the default positioning mode; Finale uses proportional spacing to place the notes in 
the measure.

If the Manually (by Dragging) radio button is selected, you can drag each note in the mea-
sure into place, one by one. Finale copies the measure, but superimposes all of the notes at the 
left end of the measure; to drag them into place, click the Speedy Entry Tool and click the 
measure. Drag the notes into place.

• Position Notes Evenly Across Measure. Select this option if the measure you’re copying to 
contains more or fewer beats than are allowed by the time signature; Finale responds by spac-
ing all notes evenly within the measure, no matter how few or how many.
To find out more about these positioning modes, see MEASURE ATTRIBUTES DIALOG BOX, 
KEY SIGNATURE DIALOG BOX and TIME SIGNATURE DIALOG BOX.

• OK. Click OK (or press enter) to confirm the settings you’ve made in this dialog box. You 
return to the Measure Items box, where you’ll see that Measure Positioning is now selected.

• Cancel. Click Cancel to tell Finale to ignore any settings you’ve made. You return to the Mea-
sure Items box, where you’ll see that Measure Positioning has not been selected.
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Copy Measure Width dialog box
How to get there

Select a region with the Mass Mover Tool l. From the Mass Mover Menu, choose Copy Mea-

sure Items. From the Measure Items box that appears, select Measure Widths.

What it does
When you’re about to copy only certain elements of a selected region to another region—specifi-
cally Measure Widths—you can use this dialog box to specify that certain changes be made to the 
resultant copy.

• No Change. If this radio button is selected, the copying process you’re about to perform won’t 
affect measure widths. You’re simply telling Finale to copy these elements to a target region 
exactly as they appear in the source region. (This item has no effect unless you’re in the pro-
cess of copying a selected region.)

• Set Width To. If this radio button is selected, you can fix their widths at a uniform measure-
ment by entering a measurement into the box.

• Add To Current Width. This option lets you modify the copies of all selected measures at 
once, thus preserving any variations within the selected region. Enter the amount by which 
you want the widths of the copied measures increased (positive number) or decreased (nega-
tive number) relative to the widths of the source measures.

• OK. Click OK (or press enter) to confirm the settings you’ve made in this dialog box. You 
return to the Measure Items box, where you’ll see that Measure Widths is now selected.

• Cancel. Click Cancel to tell Finale to ignore any settings you’ve made. You return to the Mea-
sure Items box, where you’ll see that Measure Widths has not been selected.

Cut Measures and Cut Music dialog boxes

How to get there

Click the Mass Mover Tool l, and select a region of music. Choose Cut from the Edit Menu.
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What it does
When you indicate that you want to delete some music, Finale can remove either the music alone 
from the specified region (leaving behind empty measures) or the measures themselves (removing 
the measures from the piece completely). This dialog box lets you specify whether or not Finale 
should remove the measures from the piece.

• Clear. Select Clear (or press enter) if you want to remove music from the score, leaving 
behind only rests. (You can undo this action by choosing Undo from the Edit Menu.)

• Delete. Select Delete if you want to remove the selected material from the score completely, 
shifting the following music to the left to fill in the gap. You end up with fewer beats or mea-
sures in the score, and Finale rebars the music as necessary. Important: If full measures have 
been selected, Finale will remove the music from every staff in the score, even if you only 
selected the measures in one staff. (You can undo this action by choosing Undo from the Edit 
Menu.) Be sure that you haven’t disabled Undo in the program before deleting any music you 
aren’t sure of (see PROGRAM OPTIONS DIALOG BOX).

• OK • Cancel. Click OK or press enter to execute the selected option. Click Cancel if you 
decide not to remove any music. You return to the score. (If you chose Cut from the Edit 
Menu, the measures you selected are still copied to the Clipboard, just as though you’d copied 
them).

Items to Clip dialog box
How to get there

Click the Mass Mover Tool l, and select a region of music. While pressing shift, choose Cut 

and Filter or Copy and Filter from the Edit Menu. (If you’re about to create a Clip File, which can 
be saved separately on the disk, press both ctrl and shift when you choose Cut or Copy.)
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What it does
When you cut or copy music from your score, Finale usually copies every note- and measure-
related element of your music. (The only exceptions are measure-assigned text blocks, measure-
assigned Ossia measures, and continuous MIDI data.)
In this dialog box, however, you have the option of excluding some of the score elements—lyrics 
or expression, for example. See also COPYING MUSIC. If you’ve chosen Cut from the Edit Menu, 
Finale still removes all music from the selected region; the Items to Clip dialog box merely lets 
you specify which elements of the music you want placed on the Clipboard (ready for pasting 
elsewhere in the score).

• Expressions and Smart Shapes (Assigned to Measures). If this checkbox is selected, Finale 
will include any existing measure attached expressions and Smart Shapes in your Clipboard 
selection.

• Repeats. If this checkbox is selected, Finale will include any repeat barlines or text repeats 
(created with the Repeat Tool) in the Clipboard selection.

• Entry Items. An entry item is anything associated with a note or rest—lyrics, chord symbols, 
articulations, note attached expressions, beam modifications, and so on. If you want to elimi-
nate some of these elements from the selection, click the Entry Items box, then click it again; 
the Entry Items dialog box appears. Click only those you want included in the Clipboard 
selection—but you must include the notes (Entries) themselves. See ENTRY ITEMS DIALOG 
BOX.

• OK • Cancel. Click OK (or press enter) to confirm your selections. If you chose Cut, Finale 
now asks whether you intend to clear the selected measures (leaving them empty) or delete 
them (removing them from the score completely). If you pressed ctrl while choosing Cut or 
Copy, Finale now asks you to title the Clip File you’re creating. Click Cancel to return to the 
score without cutting or copying anything.
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Measure layout
For information regarding the relative widths of the measures in a particular system, see MEA-

SURES—To adjust measure widths in a system.
You can easily control the page layout of measures in Finale through the use of measure groups. A 
measure group is a set of measures fastened to each other; even if the arrangement of other mea-
sures changes, those in a group will remain together in the same system.
This kind of control over measure layout is especially useful when you’re fine-tuning a piece’s 
layout—avoiding an awkward page turn, forcing a key change to fall at the beginning of a system, 
and so on. 
Note that the measures you rearrange in the following instructions become locked into the 
arrangement you specify; they won’t be affected by future measure-rearranging commands like 
Update Layout or even Begin a New Staff System (see “To create a system break,” below). To 
lock measures into place, select the systems you wish to affect and press L. These locked mea-
sures will not be affected by updating the layout (unless Remove System Locks is selected in the 
Update Layout Options dialog box) or rearranging the measures in other systems. 
To remove measure groups from the piece choose Update Layout from the Edit Menu or highlight 
the systems or region with the Mass Mover and press U. If Maintain System Locks is selected in 
the Update Layout Options dialog box select Update Layout while pressing shift. See UPDATE 
LAYOUT OPTIONS DIALOG BOX for more information on Update Layout settings.

To move a measure to the previous (or next) system
Before you perform this or any significant page layout action, be sure to choose Update Layout 
(ctrl-U) from the Edit Menu. (If you’re in Page View, be sure to choose Update Layout while 
you’re viewing the first page, since Update Layout only affects the region from the current page to 
the end of the piece.)
• If you’re not in Page View, choose Page View from the View Menu. 

• Click the Mass Mover Tool l, and click the measure to be moved. If you want to move 

more than one measure to the next system—the last two on a line, for example—click the first 
measure of the group to be moved. If you want to move more than one measure to the previous 
system, click the last measure of the group to be moved.

• Press the ↑  or  ↓  key. If you press ↑ , the selected measure (and any that precede it in the sys-
tem) move to the previous system. If you press ↓ , the measure or measures move to the next 
system or are consolidated if you are editing the last 2 systems. In either case, Finale then 
automatically adjusts the layout, just as though you’d chosen Update Layout from the Edit 
Menu.
What you’ve just done is to create a measure group, Finale’s system of locking measures 
within a system. Be aware, however, that once a measure has been manipulated in this way, 
the measures in its new system are locked into this arrangement, and won’t be affected by 
future measure-rearranging commands. To remove measure groups from the piece highlight 
the systems with the Mass Mover and press U or choose Update Layout from the Edit Menu 
while pressing shift.
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To force selected measures into one system
Where the up/down-arrow trick works well to push a single measure into a different system, 
sometimes it’s useful to say: “I want these three measures, and only these, in one system.”

• If you’re not in Page View, choose Page View from the View Menu. 

• Click the Mass Mover Tool l, and select the measures you want to group. To select the 

first measure of the group, click it (or, if Select Partial Measures is selected in the Mass Mover 
Menu, double-click it); then shift-click the last measure of the group. You may also drag-
enclose the measures you want; in any case, they should now be highlighted.

• Choose Fit Music from the Mass Mover Menu. A dialog box appears.
• Click Lock Selected Measures Into One System. Click OK. Finale places the selected mea-

sures into a system by themselves, then does an automatic Update Layout.

To specify a number of measures per system
See MEASURES PER LINE.

To remove measure groups through the end of the piece
This process will undo the procedures above, restoring all measures to “floating” status—in other 
words, their system affiliation may change as the page layout changes.

• Choose Update Layout from the Edit Menu. If Maintain System Locks is selected in the 
Update Layout Options dialog box, press shift while selecting Update Layout, or deselect this 
option. Shift–Update Layout works exactly like the normal Update Layout command in one 
respect: it only affects the pages of your piece from the page you’re viewing to the last page. If 
you’ve carefully created measure groups on the first page, for example, you won’t disturb 
them if you perform a shift–Update Layout command while viewing page 2. See UPDATE 
LAYOUT OPTIONS DIALOG BOX.

To remove measure groups for individual systems
This process will undo the procedures above, restoring all selected systems to “floating” status—
in other words, their system affiliation may change as the page layout changes.

• Select the systems to remove measure groupings and -U. This will unlock all the locked 
systems in the selected region.

To create a system break
You can command a specified measure to begin a new system, no matter what the measure layout 
may be in other systems.

• Click the Measure Tool z; double-click the barline handle of the measure you want 

to begin a new system. The Measure Attributes dialog box appears.
• Select Begin a New Staff System. Click OK (or press enter). 
• Choose Update Layout from the Edit Menu. The specified measure now begins a new sys-

tem. It will always begin a new system, no matter how the page layout changes.

To split a measure across a line break
See MEASURES—To split a measure across a line break.
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Clear Items dialog box
How to get there

Click the Mass Mover Tool l, and select a region of measures. Choose Clear Items from the 

Mass Mover Menu.

What it does
This dialog box lets you specify which elements of the music Finale should remove when you use 
the Clear Items command.

• Everything. Select this button if you want every element of the music (including lyrics, chord 
symbols, notes, expressions, and so on) removed, leaving behind empty measures. (This is the 
same as highlighting a region of music and hitting the backspace key.)

• Only the Selected Items. Select this radio button if you want to erase only certain elements of 
the selected music. The two options below (Measures and Entries) become available.

• Measures. When you select this checkbox, the Measure Items dialog box appears, listing var-
ious measure-specific elements of the music you can erase, including Smart Shapes, measure 
expressions, measure-assigned text blocks, and so on. (See MEASURE ITEMS DIALOG BOX.) 
Select any of these items you want to erase, and click OK.

• Entries. When you select this checkbox, the Entry Items dialog box appears, listing various 
note-specific elements of the music you can erase. These include lyrics, chord symbols, 
expression marks, and so on. (See ENTRY ITEMS DIALOG BOX.) Select any of these items you 
want to erase, and click OK. (If you specify in the Entry Items dialog box that you want to 
erase Entries, Finale will also remove everything attached to those notes—lyrics, expression 
marks, chord symbols, and so on.)

• OK • Cancel. If you’ve selected Everything, click OK (or press enter) to return to the score, 
and Finale removes all music from the selected region. If you’ve selected Only the Selected 
Items, but haven’t specified Measures or Entries, you return to the score, and nothing is 
erased. Click Cancel to return to the score without having erased anything.
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Erasing
You can erase any individual element of music from any specified region: lyrics, chord symbols, 
articulations, and so on, without removing any actual notes. If you want, you can also quickly 
erase all elements, including notes, from the desired region.

To erase everything from a selected region

• Click the Mass Mover Tool l and select a region. See SELECTING MUSIC for some 

region-selecting shortcuts.

• Press the backspace key or select Clear Entries and Smart Shapes from the Measures 
submenu of the Mass Mover Menu. Finale erases all music, leaving empty measures behind. 
(If you want to remove the measures too, press the delete key instead.)

To erase a note, rest, or chord

• Click the Simple Entry Tool 4.

• Click the Eraser Tool ø, then click the note, rest or chord. The entire note, rest, or 

chord disappears, and the music that follows it slides to the left to fill the space.

To erase a note from a chord

• Click the Speedy Entry Tool a. Click the measure in question. 

• Click the notehead you want to delete. You can also use the arrow keys to position the inser-
tion bar and crossbar on the notehead.

• Press backspace. Alternative method: Click the Simple Entry Tool 4, click the Eraser 

icon ø, and click directly on the notehead to be erased.

To erase selected elements from a selected region

• Click the Mass Mover Tool l and select a region. See SELECTING MUSIC for some 

region-selecting shortcuts.

• Choose Clear Items from the Mass Mover Menu. The Clear Items dialog box appears, list-
ing two categories of items to erase: Measures and Entries. See CLEAR ITEMS DIALOG BOX.

• Click Only the Selected Items. The Measure and Entries checkboxes become available.   
These include markings and other data affiliated with certain measures (not attached to any 
note). 

• Click Measures or Entries. A dialog box appears, listing the elements as shown above. See 
MEASURE ITEMS DIALOG BOX and ENTRY ITEMS DIALOG BOX for more detail.

• Click each item(s) you want to erase. You can select more than one item. Click OK, and if 
necessary choose items from the each of the two dialog boxes.

• Click OK (or press enter) twice. Finale erases the selected items. (You can undo this action 
by immediately choosing Undo from the Edit Menu.)
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SmartFind and Paint dialog box
How to get there

Select a region in a single staff with the Mass Mover Tool l. From the Mass Mover Menu, 

choose Set SmartFind Source Region. From the Mass Mover Menu, choose Apply SmartFind and 
Paint.

What it does
This dialog box allows you to copy items, such as articulations, expressions, slurs and other Smart 
Shapes, to rhythmically identical regions, leaving the pitches intact. Use the checkboxes to control 
what markings to copy or paint onto the target measures. See also TO COPY SCORE MARKINGS 
BASED ON A RHYTHMIC MATCH.

• Slurs • Articulations • Smart Shapes • Note Expressions • Measure Expressions. Check 
the items Finale should create in the target measures. Check Slurs to paint slurs created with 
the SMART SHAPE TOOL. Check Articulations to paint articulations created with the ARTICU-

LATION TOOL. Check Smart Shapes to paint any non-slur Smart Shapes created with the 
SMART SHAPE TOOL. Check Note Expressions or Measure Expressions to paint markings 
created with the EXPRESSION TOOL. SmartFind will copy any Measure Expression, but will 
paint Measure Expressions with a setting of “This Staff Only.” See MEASURE EXPRESSION 
ASSIGNMENT DIALOG BOX.

• Delete Target Markings Before Paint. Check this box to erase selected markings in the tar-
get region before painting new markings. To preserve markings in the target region, uncheck 
this box. Note that checking this option will only erase markings checked to paint. For exam-
ple, if all markings to paint were checked except articulations, SmartFind would erase mark-
ings in the target but leave articulations untouched. The checked marking types will be deleted 
regardless of whether the markings appear in the source region.
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• Find • Find Next. Click the Find button to search for the first rhythmic pattern match. After 
finding the first match, the button will change to Find Next. Finale will search in the following 
order: first measure of the top staff in the selected region to the last measure of the top staff in 
the region, layers one to four and finally, down through the rest of the staves. SmartFind and 
Paint will match rhythmic patterns beginning anywhere in a measure, not just at the start of a 
whole beat. Finale will treat the rhythmic pattern in terms of pitch durations, not necessarily 
individual notes. For example, Finale will match a quarter note with two tied eighth notes. 
SmartFind and Paint ignores grace notes, Voice 2 notes and mirrors. See MULTIPLE VOICES 
and MIRRORING. Only rhythms and markings in the current layer of the source region are used 
for the pattern matching and painting process. Patterns in all layers of the target region are 
considered for matches.

• Paint. Click the Paint button to copy the source markings into the measure found by Smart-
Find and Paint. Only the markings on the first note of a group of tied notes are painted to the 
target measures.

• Paint All. Click the Paint All button to copy the source markings into all measures found by 
SmartFind and Paint in the target region. Clicking Paint All after clicking Find/Find Next 
paints the current and all remaining matches in the target region. Measures skipped before 
clicking Paint All are left untouched.

• Cancel/Close. Click Close or Cancel to tell Finale you’re done. You return to the score.

Apply Articulation dialog box
How to get there

Click the Mass Mover Tool l, and select a region of measures (or part of a measure). From the 

Mass Mover Menu, choose Apply Articulation.

Or, click the Articulation Tool t and drag-enclose a series of notes.

What it does
The Apply Articulation dialog box lets you apply an articulation mark (such as an accent or stac-
cato mark) to every note in a selected region. In fact, you can even apply a marking only to every 
quarter note, for example.
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• Articulation • Select. The Articulation text box identifies, by number, the articulation mark-
ing you’re about to place on the selected notes. (The articulations in Finale’s articulation pal-
ette are numbered left to right, top to bottom, starting from 1.)
Instead of typing in a number, it may be more convenient to click Select. Finale displays a pal-
ette of all articulations you’ve created (or loaded) in this document. Double-click the one you 
want; you return to the Apply Articulation dialog box, where that marking’s number appears 
in the text box.

• All Notes. Leave this option selected if you want the selected articulation to appear on every 
note or chord in the selected region.

• Notes Within Range of Durations • From • Through • EDUs. It doesn’t make much sense 
to put a staccato mark on a whole note; nor is a fermata found very often on a 32nd note. For 
this reason, you can specify what kinds of notes you want to receive the selected articulation. 
In the From palette, click the smallest note value—and in the Through palette, click the long-
est note value—you want to receive the marking. All notes between (and including) those two 
note values will be affected. (To specify a dotted rhythm, click the dot as well; click the dot 
again to specify a non-dotted rhythm.)

If you only want quarter notes, eighth notes, and sixteenth notes to have staccato marks, then, 
click the sixteenth note in the From row, and the quarter note in the Through row. Finale won’t 
apply staccato marks to whole notes, half notes, 32nd notes, for example.
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If the note-duration you’re looking for doesn’t appear in the palette—for example, if you want 
to specify a quintuplet quarter note—you can calculate its EDU value and enter that number 
directly into one of the EDUs boxes. There are 1024 EDUs per quarter note; you’d enter 1024 
for a quarter note, 128 for a sixteenth, and so on.

• Include Notes that Start a Tie. You usually wouldn’t expect to find a cesura (full stop, or 
“railroad track”) on a note that begins a tie; the tie and the marking contradict each other. For 
cases like this, you can deselect this checkbox, and Finale won’t apply the selected articula-
tion to any note that’s tied to a later note.

• Include Notes that Continue or End a Tie. Similarly, you normally wouldn’t expect to find 
an accent mark on a note that’s tied over from a previous note. Select this checkbox if, for 
some reason, you do want Finale to place the selected articulation on notes that are tied from a 
previous note.

• Additional Positioning: H: • V:. To specify a particular position for the articulation you’ve 
selected (beyond any “smart” positioning it’s been given using the Articulation Designer dia-
log box), enter numbers into these boxes.

• OK • Cancel. Click OK (or press enter) to return to the score, where Finale places articulation 
markings according to your specifications—or click Cancel to return to the score without 
changing anything.

Change Articulation Assignments dialog box
How to get there

Click the Mass Mover Tool l, and select a region of measures. From the Change submenu of 

the Mass Mover Menu, choose Articulation Assignments.

What it does
Using the Change Articulation Assignments command, you can swap one articulation marking for 
another, adjust the positions of all accent marks at once (for example), or clean up the positioning 
of all articulations in a region.
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• Position All Articulations. Select this option if you want Finale to adjust the position of every 
articulation in the selected region. How it moves them depends on your setting from the Add 
to… drop-down list (see below); this item simply specifies which markings will be moved.

• Position Selected Articulation • Select. If you only want to move all occurrences of a specific 
marking, enter its number into the text box. (Finale numbers its articulations from left to right, 
top to bottom, in the Articulation Selection dialog box.) It may be more convenient, of course, 
to click Select; Finale displays a palette of all articulations created in (or loaded into) the cur-
rent document. Double-click the one you want to move; you return to this dialog box, where 
the correct number appears in the text box.

Once again, how Finale will move the articulation type you’ve selected depends on your set-
ting in the Add to… drop-down list (see below).

• Change All Articulations (or Selected Articulation) to Articulation ___ • Select. Click this 
checkbox if, instead of moving all articulations (or the selected articulation marking, depend-
ing on your choice of the top two radio buttons), you want to replace them with a different 

articulation marking. You could replace all > accent marks with ^ accent marks, for example.

To do so, enter the replacement symbol’s number in the text box, or click Select, and double-
click your selection in the Articulation Selection dialog box that appears.

Of course, if you enter numbers into the H: and V: text boxes, you can move the articulations 
as you replace them.

• Add to Default Position • Add to Current Position. If you decide to adjust the positions of 
articulations, use this drop-down list to specify how.

If you choose Add to Default Position, Finale moves each marking into the position dictated 
by its built-in “smart” settings (created in the Articulation Designer dialog box)—that is, 
according to whether it’s auto-centering, supposed to lie outside the staff lines, and so on—
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plus any additional adjustment you specify in the H: and V: text boxes (see below). (See 
ARTICULATION DESIGNER DIALOG BOX to find out more about an articulation’s auto-position-
ing settings.)

If you instead choose Add to Current Position from the drop-down list, Finale ignores what-
ever auto-positioning you’ve established for your articulations (in the Articulation Designer 
dialog box). Instead, Finale simply slides each marking—from its current position—a dis-
tance you’ve specified in the H: and V: text boxes (see below).

• H: • V:. Type numbers into these text boxes to specify how far Finale should move the speci-
fied markings. A positive or negative H: value moves them to the right or left. When an articu-
lation is positioned On notehead side, or On stem side, a positive V: value moves the marking 
away from the staff; a negative V: value moves the marking in toward the staff. Because they 
can flip from one side to another, Finale does not track their actual positions, but instead 
places them closer to or further away from the staff. When an articulation is positioned Manu-
ally, Above Note, or Below Note, a positive V: value moves the articulation up; a negative V: 
value moves the articulation down. It doesn’t matter whether the articulation is above or below 
a note.

• OK • Cancel. Click OK (or press enter) to proceed with the articulation transformation; click 
Cancel to return to the score without changing anything.

Change Chord Assignments dialog box
How to get there

Click the Mass Mover Tool l, and select a region of measures. From the Change submenu of 

the Mass Mover Menu, choose Chord Assignments.

What it does
This dialog box lets you change all chord symbols in a selected region in several ways. You can 
transpose them, turn their playback on or off, change their display to fraction-style, or move them 
by a precise amount.
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• Show: Root • Lowercase • Suffix • Fretboard • Alternate bass • Lowercase • After Root • 
Under Root • As Subtext. You can hide certain portions of the selected chord symbols. Click 
a checkbox once to make it white (meaning that this chord symbol element won’t appear), 
click a second time to make an X appear (meaning that this item will appear), and click a third 
time to make it gray again (meaning that this item will be unchanged).
Root refers to the root scale tone; if you turned this box off for a Cmaj7 chord, only the 
“maj7” would remain. The first Lowercase option determines whether the Root will appear as 
a lowercase or a capital letter.
Alternate Bass is the bass note of a chord in some inversion; if you turned this box off for a 
Cmaj7/G chord, only Cmaj7 would appear in the score. The second Lowercase determines 
whether the Alternate Bass will appear as a lowercase or capital letter. 
After Root, Under Root and As Subtext. If this checkbox appears white, all chord symbols 
will appear in normal slash style. Click a second time to make an X appear and choose Under 
Root, meaning that alternate bass notes will appear directly beneath the rest of the chord sym-
bol, fraction-style. Or, choose As Subtext to have the alternate bass notes appear below and 
slightly to the right. Click yet again to make the checkbox gray, so that the alternate-bass 
styles remain unchanged.
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• Play: Root • Suffix • Fretboard • Alternate Bass. Normally, Finale plays chord symbols 
when you play back your score. Using these three checkboxes, you can silence all of them—or 
any portion of them.
Because some chords may be set to play back and others may not (within a certain region), 
these checkboxes initially appear gray—meaning that Finale won’t change this element at all. 
To turn an item off (so it won’t play back), click the checkbox so it turns white. To turn an 
item on, click again, so that an X appears in it. Click yet again to make the checkbox gray 
again.
Root is the root scale tone (the C in a Cmaj7/G chord); Suffix represents the notes of the 
chord suffix only; Fretboard plays the entire chord as displayed in the fretboard diagram; and 
Alternate Bass is the bass note of a chord in some inversion (the G in a Cmaj7/G chord). You 
can turn playback of each of these elements on or off individually for all chords in the selected 
region.

• Transpose. Finale transposes chord symbols automatically; when you change the key of your 
piece, the chord symbols change key too, so that their harmonic relationship to the notated 
piece remains the same.

Occasionally, however, you may want to change the chord symbols’ “key” without changing 
the key of your piece. Click this button to display the Transposition dialog box, where you can 
specify a transposition of any interval. See TRANSPOSITION DIALOG BOX.

• Use Fretboard Font. Choose this item to use the default font for fretboards in Select Default 
Fonts, instead of custom fretboards.

• Capo. Check this box then enter a fret number to automatically adjust the selected fretboard to 
reflect the position of the capo for the selected region. Or enter zero to remove a capo adjust-
ment. Example: if the capo is set to the first fret and an Ef7 chord is entered, the fretboard that 
appears will be the D7 from the currently selected Fretboard Group. Also, the name of the 
chord will change to D7 even though the chord will sound as an Ef7. To change the chord 
name to an italic style, select Italicize Capo Chords from the Chord Menu.

• Fretboard Style. Check this box to change the style Finale uses to draw certain elements of 
custom fretboards. Choose a different style from the drop-down list.

• Add to Default Position • Add to Current Position. If you decide to adjust the positions of 
the chord symbols, use this drop-down list to specify how.

If you choose Add to Default Position, Finale moves each symbol into its default position (dic-
tated by its baseline and point of note attachment)—plus any additional adjustment you spec-
ify in the H: and V: text boxes (see below). (See CHORD SYMBOLS to find out more about 
specifying where chord symbols appear.)

If you instead choose Add to Current Position from the drop-down list, Finale ignores the 
chord symbols’ default positions. Instead, Finale simply slides each symbol—from its current 
position, even if you’ve dragged it by hand—a distance you specify in the H: and V: text boxes 
(see below).

• H: • V:. Type numbers into these text boxes to specify how far Finale should move the speci-
fied chord symbols (a positive H: number moves them to the right, and a positive V: number 
moves them upward). If you leave both numbers at zero, Finale won’t move them at all.
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• OK • Cancel. Click OK (or press enter) to confirm the changes you’ve made. Click Cancel to 
return to the score without changing any chord assignments.

Change Note Expression Assignment dialog 
box
How to get there

Click the Mass Mover Tool l, and select a region of measures. From the Mass Mover Menu, 

choose Change, then Note Expression Assignments.

What it does
Using the Note Expression Assignments command, you can swap one expression for another, 
adjust the positions of selected expressions at once (for example), or clean up the positioning of 
all expressions in a region.

• Position All Note Expressions. Select this option if you want Finale to adjust the position of 
every expression in the selected region. How it moves them depends on your setting from the 
Add to… drop-down list (see below); this item simply specifies which markings will be 
moved.

• Position Selected Expressions • Select. If you only want to move all occurrences of a specific 
marking, enter its number into the text box. (Finale numbers its Expressions from left to right, 
top to bottom, in the Expression Selection dialog boxes.) It may be more convenient, of 
course, to click Select; Finale displays the Expression Selection dialog box containing all the 
text and shapes you’ve created in (or loaded into) the current document. Double-click the one 
you want to move; you return to this dialog box, where the correct number appears in the text 
box.
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Once again, how Finale will move the Expression type you’ve selected depends on your set-
ting in the Add to… drop-down list (see below).

• Change All Expressions (or Selected Expression) to Expression ___ • Select. Click this 
checkbox if, instead of moving all Expressions (or the selected articulation marking, depend-
ing on your choice of the top two radio buttons), you want to replace them with a different 
Expression. You could replace all p marks with pp marks, for example.

To do so, enter the replacement symbol’s number in the text box, or click Select, and double-
click your selection in the Expression dialog box that appears.

Of course, if you enter numbers into the H: and V: text boxes, you can move the expressions as 
you replace them.

• Add to Default Position • Add to Current Position. If you decide to adjust the positions of 
Expression, use this drop-down list to specify how.

If you choose Add to Default Position, Finale moves each Expression from the center of the 
notehead (the topmost note in a chord) and adjusts by using the distances specified in the H: 
and V: text boxes (see below). 

If you instead choose Add to Current Position from the drop-down list, Finale simply slides 
each marking—from its current position—by the distance you’ve specified in the H: and V: 
text boxes (see below).

• H: • V:. Type numbers into these text boxes to specify how far Finale should move the speci-
fied markings. A positive or negative H: value moves them to the right or left, respectively. A 
positive V: value moves the marking above the staff; a negative V: value moves the marking 
below the staff. 

• OK • Cancel. Click OK (or press enter) to proceed with the expression transformation; click 
Cancel to return to the score without changing anything.

Change Ties dialog box
How to get there

Click the Mass Mover Tool l, and select a region of music. From the Change submenu of the 

Mass Mover Menu, choose Ties.

What it does
Use the Ties command to change settings of ties in a region. You can set tie direction, break ties at 
a new time or key signature, remove any manual adjustments to positioning and specify whether 
the arcs of ties should avoid staff lines. Finale updates the Tie Alterations dialog box settings for 
each tie in the region.

Note: Use the Ties command to adjust more than one tie in a region. To adjust a single tie or the 
tie end after a system break, use the settings in the Tie Alterations dialog box. See TIE ALTER-

ATIONS DIALOG BOX.
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• Tie Direction: Automatic • Over • Under. Set the direction for ties in the selected region as 
frozen under, frozen over or use Automatic to let Finale decide which direction the tie should 
go based on your settings in the Tie Options dialog box. You can also use ctrl-F to flip the tie 
without even entering the Tie Alterations dialog box.

• Break for Time Signature: Default • On • Off. Choose an option from the drop-down list to 
specify whether ties in the selected region break and continue at a time signature change. 
Default is the initial setting. When Default is selected, Finale uses the global Break for Time 
Signature setting in the Tie Options dialog box. Choose On to always break ties in the selected 
region at a time signature change and continue it immediately after the signature change, 
regardless of the global setting. Choose Off to draw ties in the selected region through the time 
signature without any break.

• Break for Key Signature: Default • On • Off. Choose an option from the drop-down list to 
specify whether ties in the selected region break and continue at a key signature change. 
Default is the initial setting. When Default is selected, Finale uses the global Break for Key 
Signature setting in the Tie Options dialog box. Choose On to always break ties in the selected 
region at a key signature change and continue it immediately after the signature change, 
regardless of the global setting. Choose Off to draw ties in the selected region through the key 
signature without any break.

• Outer Placement. When this checkbox is selected, ties in the selected region will be set to 
outer placement (unless they are inner ties on chords). Deselect this checkbox to remove outer 
placement on all ties in the selected region.

• Avoid Staff Lines. When this checkbox is selected Finale uses the global Avoid Staff Lines 
setting in the Tie Contour dialog box to determine where to position the peak of the arc in rela-
tion to staff lines. When not checked, Finale does not avoid staff lines in the selected region.

• Remove Manual Positioning. When this checkbox is selected all of the Inset, Height and H: 
and V: changes from the global settings are removed.
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• OK • Cancel. Click OK (or press enter) to save the new settings and return to the score. Click 
Cancel to return to the score without making any changes.

Change Note Durations dialog box
How to get there

Click the Mass Mover Tool l, and select a region of measures. From the Change submenu of 

the Mass Mover Menu, choose Note Durations.

What it does
This dialog box lets you halve, double, or otherwise change the note values in a selected region.

• Change All Note Durations by: 25% • 50% • 100% • 200% • 400%. Using this drop-down 
list, specify how you want to affect all notes in the selected region. For example, choose 200% 
to double every note’s rhythmic value—to turn every eighth note into a quarter, every quarter 
into a half note, and so on.

• Change Selected Note Duration From • To. Instead of changing all notes’ values, you can 
change only a specific note value; for example, you might want to double the values of eighth 
notes, but to leave all other note values alone. Specify the note value you want to replace by 
clicking its icon in the upper palette. (Click the dot, too, to specify a dotted note.) Specify the 
replacement note value by clicking an icon in the lower palette. For example, to change all six-
teenth notes into quarter notes, you’d click the sixteenth note in the top palette, and the quarter 
note in the bottom palette.
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• Include Tuplets. This option only works when Change All Note Durations is selected. If you 
select this checkbox, Finale will also transform notes within tuplets (such as triplets and quin-
tuplets) proportionally. For example, if you’re halving the rhythmic values of a passage, an 
eighth-note tuplet will become a sixteenth-note tuplet. If you don’t select this option, the 
eighth note tuplet will remain the same.

• Rebar Music. If you’re changing the values of notes in the selected measures, chances are 
that your measures will wind up containing the wrong number of beats. If this checkbox is 
selected, Finale will also rebar the music from the selection to the end of the piece—redistrib-
ute notes in their measures—so that each measure contains the proper number of beats. See 
REBARRING MUSIC for more information on Finale’s rebarring options.

• OK • Cancel. Click OK (or press enter) to confirm the changes you’ve made. Click Cancel to 
return to the score without making any changes.

Augmentation
Augmentation refers to the process of doubling a motif’s rhythmic values, so that each quarter 
note becomes a half note, and so on. In effect, the following process re-notates any passage so that 
it doubles every note’s value.

To double the rhythmic values in a passage

• Click the Mass Mover Tool l and select the region of music you want to affect. See 

SELECTING MUSIC for some region-selecting shortcuts.

• From the Change submenu of the Mass Mover Menu, choose Note Durations. The 
Change Note Durations dialog box appears.

• Choose 200% from the Change All Note Durations by drop-down list. If you want Finale 
to re-bar the selected measures so that there are half as many notes per measure, make sure 
Rebar Measures is selected. See CHANGE NOTE DURATIONS DIALOG BOX for details on these 
options.

• Click OK (or press enter). You can even double the values of the notes in a specific layer (if 
Show Active Layer Only is selected in the View Menu).

Note that this command does not affect empty measures. (A measure in which you’ve entered 
a “real” whole rest doesn’t count as empty in this context.) That is, the command will double 
the values of all notes and rests you’ve entered, but it won’t create a second completely empty 
measure.

Diminution
Diminution refers to the process of halving a motif’s rhythmic values, so that each quarter note 
becomes an eighth note, and so on. In effect, the following process re-notates any passage so that 
it halves every note’s value.
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To halve the rhythmic values in a passage

• Click the Mass Mover Tool l and select the region of music you want to affect. See 

SELECTING MUSIC for some region-selecting shortcuts.

• From the Change submenu of the Mass Mover Menu, choose Note Durations. The 
Change Note Durations dialog box appears.

• Choose 50% from the Change All Note Durations by drop-down list. If you want Finale to 
re-bar the selected measures so that there are twice as many notes per measure, make sure 
Rebar Measures is selected. See CHANGE NOTE DURATIONS DIALOG BOX for details on these 
options.

• Click OK (or press enter). You can even double the values of the notes only in one layer (if 
Show Only Current Layer is selected in the Edit Menu).

Finally, note that this command does not affect empty measures. (A measure in which you’ve 
entered a “real” whole rest doesn’t count as empty in this context.) That is, it will double the 
values of all notes and rests you’ve entered, but it won’t create a second completely empty 
measure.

Change Noteheads dialog box
How to get there

Click the Mass Mover Tool l. Select the region containing the notes you want to change. 

Choose Noteheads from the Change submenu of the Mass Mover Menu.

What it does
Use this dialog box to change the noteheads in the selected region to regular noteheads or to the 
notehead you specify.
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• Find: All Noteheads • All Custom Noteheads • Selected Notehead; Select. Specify what 
noteheads you want to change in the selected region. Choose All Noteheads to change all reg-
ular and custom noteheads in the selected region; choose All Custom Noteheads to change 
every custom notehead in the selected region; choose Selected Notehead to change only the 
notehead you specify in the selected region. To specify a particular notehead, enter its key-
board equivalent in the text box, or click Select to choose the notehead in the Symbol Selec-
tion dialog box.

• Change to: Regular Noteheads • Selected Notehead; Select. Select the replacement note-
heads for the specified noteheads in the selected region. Choose Regular Noteheads to change 
the noteheads to regular noteheads; choose Selected Notehead to change both the custom and 
non-custom noteheads to the notehead you specify. To specify a particular notehead, enter its 
keyboard equivalent in the text box, or click Select to choose the notehead in the Symbol 
Selection dialog box.

• OK • Cancel. Click OK (or press enter) to confirm the changes you’ve made. Click Cancel to 
return to the score without making any changes.
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Change Note Size dialog box
How to get there

Click the Mass Mover Tool l, and select a region of music. From the Change submenu of the 

Mass Mover Menu, choose Note Size.

What it does
Using the Change Note Size dialog box, you can change the sizes of all notes in a selected region. 
It’s especially useful for creating cue notes.

• Resize Notes to ___ %. In this text box, enter the percentage by which you want to scale all 
notes in the selected region. For example, enter 50% to make all notes half their sizes (while 
remaining on a full-size staff).

• OK • Cancel. Click OK (or press enter) to proceed with the note-resizing; click Cancel to 
return to the score without changing anything.

Elapsed Time dialog box

How to get there

Click the Mass Mover Tool l, and select a region of measures. Select Check Elapsed Time 

from the Utilities sub-menu of the Mass Mover Menu. Or press the 5 key with selected measures.

What it does
This dialog box gives the following information: (1) the amount of time that has passed from the 
beginning of the piece to the beginning of the selected region; (2) the time that has passed from 
the beginning of the piece to the end of the selected region; and (3) the total time of the selected 
region itself (all in thousandths of a second).
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• OK. Click OK (or press enter) to return to the score.

Elapsed time
If you need an accurate assessment of the real-time length of a section of music, the Mass Mover 
can help. The time displayed is based on the current tempo settings for the piece in the Playback 
Controls, including any tempo changes, ritards, and so on set up as playback effects on an expres-
sion.

To learn the real-time length of selected music

• Click the Mass Mover Tool l and select a region. See SELECTING MUSIC for some 

region-selecting shortcuts.

• Select Check Elapsed Time from the Utilities sub-menu of the Mass Mover Menu. Or, 
while pressing the 5 key, double-click the highlighted area. A dialog box appears, display-
ing (1) the amount of time that has passed from the beginning of the piece to the beginning of 
the selected region; (2) the time that has passed from the beginning of the piece to the end of 
the selected region; and (3) the total time of the selected region itself (all in thousandths of a 
second).

• Click OK (or press enter). 

Explode Music dialog box
How to get there

Click the Mass Mover Tool l, and select a region of measures. From the Utilities submenu of 

the Mass Mover Menu, choose Explode Music.
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You can also use a Mass Mover Metatool: press the 2 key with selected measures. Or, hold down 
E while dragging selected measures to a destination.

What it does
In essence, Finale’s Explode Music command strips a chordal passage into individual single-line 
melodies on separate staves. You could use this feature, for example, to transform a piano reduc-
tion into four single-line melody staves for a choir.

Before it will “explode” the selected region, however, you have to tell Finale, in this dialog box, 
how many resultant staves you want, what clefs they should use, and how Finale should handle 
cases where there are more notes (or fewer notes) in a chord than there are staves on which the 
music will be exploded.

• Split into__ Staves. This number specifies how many resultant staves Finale should create. 
You can create up to eight staves.
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• Explode Direction: Top Down • Bottom Up. These options decide how Finale will fill the 
staves receiving music, especially when some chords have fewer notes than the chords around 
them. For example, when you are exploding music onto four new staves, and there is a chord 
which only contains three notes, Top Down will place the three note chord on the top three 
staves, leaving the bottom staff empty. Using the same example you can make the lower three 
voices receive notes, (leaving the top staff blank) by selecting Bottom Up.

• Extra Notes: Put in Top Staff • Put in Bottom Staff • Distribute to These Staves __ • Dis-
card. These options are used when there are more notes in a chord than there are staves 
selected in the Split Into text box to determine how to deal with the overflow of notes. Finale 
will divide the number of notes by the number of staves, with the remainder being the extra 
notes. If Only One Note per Staff is selected, at most one note will be assigned to each staff. 
When Put in Top Staff is selected, all extra notes from a chord will be placed in the topmost 
exploded staff. When Put in Bottom Staff is selected, all extra notes will be placed in the bot-
tom most exploded staff. Discard will put the same number of notes on each staff and throw 
the extra notes away.

When Distribute to These Staves__ is selected, it allows you to decide, explicitly, which 
staves will receive extra notes. For example, if you’re exploding the music from a chordal pas-
sage into three staves, and one of the chords contains five notes, this box decides which staves 
are allowed to receive more than one note of the chord, therefore, guaranteeing all the notes in 
the chord will be present in one of the resulting staves.

In the example above, if you left the default numbers in this box (12340000), Finale would 
recalculate how the notes are to be distributed from the original five-note chord, allowing 
more than one note from the chord to appear in staff one and staff two. That is, it would notate 
the top two notes on the first exploded staff, the next two on the second staff, and the fifth (bot-
tom) note on the third exploded staff. If the Distribute to These Staves was 22222222, how-
ever, Finale would place all the “extra” notes (the top three of the original five-note chord) on 
the second exploded staff; the remaining staves would receive one note apiece.

• One Note per Staff. Select this check box to ensure each staff receives at most one note when 
exploding music. All extra notes in the chord will then be distributed according to your Extra 
Notes settings.

• Use These Clefs. If you select this checkbox, Finale will consult the numbers in the text box 
to decide what clef to give each of the resultant exploded staves. The numbers in the text box 
are clef numbers, see CLEF DESIGNER DIALOG BOX for which numbers represent which clefs. 
The first number specifies the clef for the first exploded staff; the second number specifies the 
clef for the second staff, and so on.

• Place Music into: New staves Added to Bottom of Score • Existing Staves Starting with. 
Select New Staves Added to Bottom of Score if you want Finale to create a number of new 
staves (specified by the Split Into__Staves box) below the source Staff. Select Existing Staves 
Starting with to explode your music onto existing staves starting with the staff selected in the 
drop-down list (replacing whatever music is currently on them).

• OK • Cancel. Click OK (or press enter) to proceed with the exploding process. Click Cancel 
to return to the score without exploding any music.
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Exploding music
If you have notated a chordal or polyphonic passage, you can tell Finale to “explode” the passage 
onto individual monophonic staves. For example, you can write three trumpet parts on a single 
staff, notated as triads; when you’re finished, Finale can explode that one staff into three individ-
ual trumpet staves, each with a single-line part.

The Explode Music command can place the top note of each chord in the top exploded part, the sec-
ond note in the second, and so on. You can specify the clefs for the resultant staves beforehand.

To explode music onto several staves

• Click the Mass Mover Tool l and select a region. See SELECTING MUSIC for some 

region-selecting shortcuts.

• From the Utilities submenu of the Mass Mover Menu, choose Explode Music. The 
Explode Music dialog box appears, asking for more information.

• Enter the number of staves you want the music exploded onto in the Number of Splits 
box. You can create up to eight staves.

• Decide your explode direction. You can select either Top Down or Bottom Up.

•  Select where extra notes should be placed. Extra notes can be placed in the Top Staff, Bot-
tom Staff, Distributed to a number of staves, or discarded all together.

• If you would like to have at most one note in every staff, select Only One Note per Staff. 

• Optional: Enter the desired clefs for the exploded staves, and click Use These Clefs. 
Finale numbers each clef as follows: Treble (0), Alto (1), Tenor (2), Bass (3), Percussion (4), 
Treble Ottava Bassa (5), Bass Ottava Bassa (6), and Baritone (F clef) (7).

If you’re exploding a triadic passage onto staves for violin (treble), viola (alto), and cello 
(bass), for example, you’d type 013 as the first three digits in the Use These Clefs box. (If you 
just want all exploded staves to begin with the default clef—the treble clef, unless you’ve 
changed the default—leave the Use These Clefs box unchecked, and ignore the numbers.)

• Select the staves you want to contain the exploded music. You can select either New staves 
or Existing staves.

• Click OK. If you’ve selected a large amount of music, this process may take time. Be aware 
that Articulations and Expressions on the source staff also appear in the resultant staves.
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Implode Music dialog box
How to get there

Click the Mass Mover Tool l, and select a region of measures. From the Utilities submenu of 

the Mass Mover Menu, choose Implode Music.

You can also use a Mass Mover Metatool: press the 1 key with selected measures. Or, hold down I 
while dragging selected measures to a destination.

What it does
When you implode music, Finale condenses the music on the selected staves onto a single staff, a 
feature useful for creating piano reductions, for example. This dialog box lets you specify where 
you want Finale to place the imploded music.

• New Staves Added to Bottom of Score. Select New if you want Finale to place the imploded 
music on a new staff at the bottom of the score.

• Top Staff of Selection. Select Top if you want Finale to replace the music on the top selected 
staff with the imploded music.

• Quant Settings. Click this button to display the Quantization Settings dialog box. The set-
tings in this dialog box and the More Quantization Settings dialog box affect how Finale 
implodes your music. If you are not satisfied with the results of Implode music, check these 
settings. Options like Include Voice Two and Grace Note settings are used during the Implode 
Music process. See QUANTIZATION SETTINGS DIALOG BOX and MORE QUANTIZATION SET-

TINGS DIALOG BOX.

• OK • Cancel. Click OK to proceed. Click Cancel to return to the score without imploding 
music.
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Imploding music
To implode music onto a single staff

• Click the Mass Mover Tool l and select a region. To implode music, you’ll usually 

want to select several staves by shift-clicking them. See SELECTING MUSIC for some region-
selecting shortcuts.

• From the Mass Mover Menu, choose Utilities, then Implode Music. The Implode Music 
dialog box appears, asking whether the resultant reduction should appear on a new staff (at the 
bottom of the score) or on the top selected staff (in which case its current contents will be 
replaced).

• Select either New Staves Added to Bottom of Score or Top Staff of Selection. If you’ve 
selected a large amount of music, this process may take time.

• Click OK. 

Piano reductions
See PIANO REDUCTION PLUG-IN.

To create a piano reduction for the entire piece

• Select Piano Reduction from the Plug-ins Menu. The Piano Reduction dialog box appears.

• Select the staves to be included in the piano reduction and the split point. 

• Click OK. 

To create a piano reduction over a region
See also IMPLODING MUSIC.

Using Finale’s Implode Music feature, you can condense the musical material from several staves 
onto a single staff—or, in the case of a piano reduction, onto two staves.

If the source staves contain several independent rhythms, Finale will do its best to sort them out, 
but you may still have to do some cleaning up afterward. Implode Music works best when the 
source staves have only one or two independent rhythmic patterns.

• Click the Mass Mover Tool l. 

• Select the region to be imploded onto the treble-clef staff of the piano reduction. You can 
select a region of on-screen measures by shift-clicking or drag-enclosing, or entire staves by 
shift-clicking to the left of each.

• From the Utilities submenu of the Mass Mover Menu, choose Implode Music. The 
Implode Music dialog box appears, asking whether the resultant reduction should appear on a 
new staff (at the bottom of the score) or whether the music should be imploded onto the top 
existing staff (in which case the current contents of that staff will be replaced). For more infor-
mation see IMPLODE MUSIC DIALOG BOX.
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• Click OK. If you’ve selected a large amount of music to be imploded, this process may take 
time. Note that any existing articulations and expressions in the source staves will appear in 
the resultant staff.

• Repeat the procedure for the bass-clef staff of the piano reduction. Don’t forget to change 
the clef of the bass staff (see CLEFS). If the resultant part is a rehearsal piano part that you 
want to appear at a smaller size, see REDUCING/ENLARGING.

Transposition dialog box
How to get there

Click the Mass Mover Tool l, and select a region of measures. Choose Transpose from the 

Mass Mover Menu.

What it does
In this dialog box you can specify a transposition of any interval, from a half step to many octaves, 
you want to be applied to the selected measures (or to the mirror, or to a note in the selected 
motif). 

This kind of transposition has nothing to do with the key signature; it merely transposes the 
selected music up or down by the interval you specify, adding or subtracting accidentals as neces-
sary.

• Up • Down. Choose the direction of the transposition relative to the existing notes.

• Diatonically • Chromatically. Specify what kind of transposition you want—a diatonic one 
(that moves notes up and down the scale) or a chromatic one (that can move notes by half 
steps).
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• Interval: • Perfect Unison • minor second […etc.] • Perfect Octave • Other. From this drop-
down list, choose the interval by which you want the selected music transposed. To transpose 
an interval greater than an octave, you can add one octave (or several) to the selected interval 
by entering a number in the Plus __ octaves text box (see below). If you choose Other, the 
Interval dialog box appears, so that you can specify an interval not listed in the drop-down list. 
(See INTERVAL DIALOG BOX.)

• Plus ____ octaves. If you enter a number in this text box, Finale will add that number of 
octaves to the radio-button interval you’ve specified. (You can enter a negative number if you 
want to transpose the selected music by that number of octaves in the opposite direction from 
the radio-button interval you’ve specified.)

• Preserve Original Notes. Select this option when you want to keep the original line of music 
when transposing notes to a selected interval. In effect, you’re doubling the notes in your 
score. When this option is not selected, Finale transposes the existing line of notes without 
keeping the original line.

• OK • Cancel. Click OK (or press enter) to confirm, or Cancel to discard, your transposition 
selection. If you click OK, Finale performs the transposition.

Transposing: by interval
This entry discusses the transposition of the music in selected measures up or down. If you’re 
interested in transposing the key of a section, see TRANSPOSING: CHANGING KEY. If you want to 
find out about transposing instruments, see TRANSPOSING INSTRUMENTS.

To transpose a region

• Click the Mass Mover Tool l and select a region. See SELECTING MUSIC for some 

region-selecting shortcuts.

• Choose Transpose from the Mass Mover Menu. The Transposition dialog box appears. 

• Specify the desired transposition, including Up or Down. If you want to transpose the 
selected region by more than an octave, enter the number of octaves Finale should add to the 
specified smaller interval transposition. (For example, the interval of a tenth is a third plus one 
octave.) 

If you’re performing a chromatic transposition, choose Chromatically from the upper-right 
radio buttons. You’ll notice that the Interval drop-down list changes to list chromatic inter-
vals—Minor Sixth, Diminished Fifth, and so on. See TRANSPOSITION DIALOG BOX for more 
information.

• Click OK (or press enter). To undo the transposition, choose Undo from the Edit Menu (or 
press ctrl-Z).
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Transposing: changing key
This entry provides instructions for transposing the key of a piece (or part of a piece). If you want 
to transpose a passage without changing the key signature itself, see TRANSPOSING: BY INTERVAL. 
If you want to find out about transposing instruments, see TRANSPOSING INSTRUMENTS.

To transpose a piece (Key Signature Tool)
To transpose an entire piece or a region, see KEY SIGNATURES.

To transpose chord symbols
See CHORD SYMBOLS—To transpose chord symbols.

To enter pre-transposed music onto a transposing staff (step time)
You might wonder how Finale handles notes you input on a transposing staff—does it consider 
the notes you’re entering to be the concert pitches or the written ones? When you’re using the 
step-time music entry tools (the Simple Entry and Speedy Entry tools), it’s up to you. 

The following instructions show you how to specify that the notes you’re entering have already 
been transposed—for example, if you’re copying an existing score.

• Choose Display in Concert Pitch from the Options Menu if there is a checkmark next to 
it. You’ll see by the key signatures that Finale is displaying the transposing staves in their 
transposed form. In this mode, any new notes you enter with either step-time input tool are 
considered already transposed. In other words, if you play a C on the MIDI keyboard, it 
appears as a C on the transposed staff, even though it will play back as some other note, 
because you’ve just entered a written C.

If you want to enter the concert pitches, choose Display score in Concert Pitch again from the 
Options Menu (so that the checkmark appears next to the menu item). Finale displays the con-
tents of transposing staves at concert pitches. Any music you enter with either step-time input 
tool is now considered at concert pitch; when you turn Display in Concert Pitch off, it will be 
appropriately transposed.
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Interval dialog box
How to get there

Click the Mass Mover Tool l, and select a region of music. From the Mass Mover Menu, 

choose Transpose. From the Interval drop-down list, choose Other.

What it does
If, when you’re transposing some music, none of the intervals listed in the Interval drop-down list 
represent what you want, you can use this dialog box to specify any other interval.

• Interval • Alteration. In the Interval text box, enter the number of diatonic (scale degree) 
steps—and in the Alteration box, enter the number of chromatic steps—by which you want 
the selection transposed. For example, to transpose something up or down a tritone (so a C 
would become Fs, for example), enter 4 as the Interval, and 1 as the Alteration (4 diatonic 
steps, plus one chromatic step). If you’ve selected Diatonically in the Transposition dialog 
box, the Alteration box is dimmed.

• OK • Cancel. Click OK (or press enter) to confirm, or Cancel to discard, your interval setting 
and return to the Transposition dialog box.

Rebar Options dialog box
How to get there

Click the Mass Mover Tool l; select a region. From the Rebar submenu of the Mass Mover 

Menu, choose Rebar Options.

What it does
When you change the time signature of a score, use the Rebar command, or add too many notes to 
a measure, Finale can automatically redistribute the notes in your score so that each measure con-
tains the proper number of beats. In this dialog box, you can specify how far you want Finale to go 
with this rebarring—all the way to the end of the piece, only to the next major section, and so on. 
(In the process, Finale adds or deletes measures as necessary. If there aren’t enough notes to fill 
the last measure before the stopping point, Finale adds enough rests to round out the measure.)
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• The End of the Region. If you select this checkbox, Finale will only rebar music to the end of 
the selected region. No music after that point will be affected.

• Key Signature Changes • Time Signature Changes • Special or Repeat Barlines, or Forward 
Repeats. If you select these checkboxes, Finale’s rebarring process won’t proceed past the next key 
or time signature change. A “special barline” is a double, solid, dotted, or other unusual barline; a 
repeat barline is one you’ve created using the Repeat Tool.

• Empty Frames. A frame is one measure of one staff. Therefore, if you select this option, 
Finale will only rebar music as far as the next empty measure.

• Rebeam. If this checkbox is selected, Finale will also rebeam eighth notes (and smaller val-
ues) as necessary, in the process correcting any irregular beaming patterns introduced by the 
rebarring.

• OK • Cancel. Click OK (or press enter) to confirm, or Cancel to discard, your rebarring stop-
ping-point selections. 

Note, if you didn’t select any of the checkboxes, Finale will rebar your score all the way to the 
end of the piece whenever it’s asked to rebar (when you change the time signature, insert a 
partial measure, use the Rebar command, and so on).

Rebarring music
Finale’s rebarring feature is extremely powerful: almost instantly, it redistributes the notes of your 
score so that each measure contains the right number of beats. You can renotate a waltz as a two-
step, or vice versa. 

In the Time Signature dialog box, there is a checkbox called Rebar Music. As long as this check-
box is selected, Finale will rebar your music automatically whenever you change the time signa-
ture. There are only two circumstances, therefore, when you might need to invoke the Rebar 
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Music command manually—when the checkbox is de-selected, or when you insert (or delete) a 
note from a measure, and you want Finale to make the following notes flow into (or out of) that 
measure to take up the slack.

Whether you use the Rebar Music checkbox, or manual rebarring feature, Finale is smart enough 
to split or combine notes as needed, rebeam the notes, and stop rebarring at points you designate 
(such as key or time changes); the program will also create measures as necessary. If Finale 
reaches one of these stopping points but doesn’t have enough notes leftover to fill an entire mea-
sure, it will fill this final measure with the appropriate number of rests.

When you rebar partly-filled measures, Finale does not “pad” the measures with rests. For exam-

ple, if you’re in  time, and you enter two quarter notes (and no rests) in each of two measures, 

when you rebar the music, you’ll end up with one measure containing 4 quarter notes. To maintain 
the positions of the rests, you must actually enter the rests, or you can “pad” the measures with 
rests using the Fill With Rests command located in the Utilities sub-menu of the Mass Mover 
Menu.

To rebar existing music manually

• Click the Mass Mover Tool l, and select the region you want rebarred. 

• Select how you want your music rebarred using the Rebar Options dialog box. (See 
REBAR OPTIONS DIALOG BOX.)

• From the Rebar submenu of the Mass Mover Menu, choose Rebar Music. Finale redis-
tributes the notes, so that each selected measure contains the correct number of beats, but 
respecting your settings in the Rebar Options dialog box.

Rebeam to Time Signature dialog box
How to get there

Click the Mass Mover Tool l, and select a region of measures. From the Rebeam submenu of 

the Mass Mover Menu, choose Rebeam to Time Signature.

What it does
Finale normally beams the eighth notes (and smaller values) in your piece according to the time 

signature. In other words, if the meter is , Finale groups eighth notes together in quarter-note 

groups (two to a beam). To specify a certain beaming pattern before you enter music, be sure to 
change the time signature accordingly; see BEAMING for a complete discussion.

If you need to change the beaming of your piece after you’ve already entered the music, however, 
you can do so in this dialog box, which looks identical to the one in which you set the time signa-

ture. You can even rebeam your piece in asymmetrical groupings—3+3 eighth notes in , for 

example.
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The basic rhythmic value you use to define the “meter” in this window defines the new beaming 

patterns. For example, you can create  as six individual eighth notes (no beaming), as two dotted 

quarter notes (notes beamed in groups of three), and so on.
 

• Composite. Click this button to display the Composite Time Signature dialog box, where you 
can create a “beaming” signature that includes asymmetrical groupings of notes on each beam 

( , for example, to group eighth notes into groups of 3 and 3 in ). See COMPOSITE TIME 

SIGNATURE DIALOG BOX.
• Number of Beats. Using this scroll bar, you can increase or decrease the top number of the 

new “beaming signature.” Watch the display, which shows you the groupings your newly 
rebeamed notes will fall into.

• Beat Duration. Using this scroll bar, you can increase or decrease the bottom number of the 
new “beaming signature.”

• OK • Cancel. Click OK (or press enter) to return to the score; Finale rebeams the selected 
measures according to your specifications. Click Cancel to tell Finale to exit the dialog box 
without rebeaming anything.

Rebeam to Lyrics dialog box
How to get there

Click the Mass Mover Tool l, and select a region of measures. From the Rebeam submenu of 

the Mass Mover Menu, choose Rebeam to Lyrics.
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What it does
A convention used in opera or art song notation is beaming to lyrics. In this scheme, eighth, six-
teenth, and shorter notes are never beamed together in the vocal line except when a syllable is sus-
tained through more than one note (as a melisma).

This dialog box lets you specify the lyrics you want rebeamed in this way.

• Break Beams at Each Syllable in: All Lyrics • All Verses • All Choruses • All Sections. 
When the first radio button is selected the drop-down list allowing you to select All Lyrics, All 
Verses, All Choruses, and All Sections is used. With this menu you can instruct Finale to 
impose word-by-word beaming for a certain lyric type, such as Verses or Sections. (Verses, 
Choruses, and Sections are functionally identical; they just give you a convenient method of 
subdividing your lyrics.)

• Verse • Chorus • Section ___. When the second radio button is selected, this drop-down list 
and the associated text box are used. With this drop-down list you can select a specific set of 
lyrics whose notes you want to rebeam. Choose the lyric type from the drop-down list, then 
type the lyric number (Verse 1, for example) into the text box. 

• Also Break Beams at Each Beat in the Time Signature. Select this checkbox if you want 
the beams in melismatic passages (where a single syllable is sustained through more than one 
note) broken at the beginning of each beat, as they would be if they were beamed normally, 
according to the time signature. If you don’t select this option, Finale will beam together all 

notes in a melismatic passage, even if it results in (for example) all eight eighth notes in a  

measure being beamed together.

• OK • Cancel. Click OK (or press enter) to confirm the settings you’ve made; you return to the 
score, where Finale performs the rebeaming operation. Click Cancel if you decide not to do 
any rebeaming. You return to the score.
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Retranscription
To retranscribe a region
• Choose Quantization Settings from the Options Menu. The Quantization Settings dialog 

box appears.

• Change the quantization settings as needed in the Quantization Settings dialog box. 
Click the note that you want to be the smallest note value and the type of quantization you 
require. Choose whether you want grace notes and an inner voice notated in the selected 
region by clicking More Settings. The More Quantization Settings d.b. appears. Change your 
settings and Click OK. See QUANTIZATION SETTINGS DIALOG BOX and MORE QUANTIZATION 
SETTINGS DIALOG BOX for more information.

• Click OK to return to the score. 

• Click the Mass Mover Tool l. 

• Select the region you want to renotate. 

• Choose Retranscribe from the Mass Mover Menu. Finale retranscribes the region accord-
ing to the new settings. All MIDI information is maintained, but if any markings appeared on 
the original notes, they are removed.

Fit Music dialog box
How to get there

In Page View, click the Mass Mover Tool l, and select a region of full measures. From the 

Mass Mover Menu, choose Fit Music. Or click the Page Layout Tool f. From the Page Layout 

Menu, choose Fit Music.

What it does
Using this powerful page-layout command, you can force Finale to place a group of selected mea-
sures onto one line (staff system) on the page. Or you can select a larger region of measures, and 
tell Finale to place them in groups of 4 (or any other number) per line. The Fit Music command 
also allows you to lock the measure grouping and the contents.
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• Lock Layout with ___ Measures per System • Treat Multi-Measure Rests as One Mea-
sure. The Measures per System option lets you specify how many measures per line you want 
for the region you’ve selected. You may optionally treat multi-measure rests as one measure 
(when checked) or count each measure inside the multi-measure rest individually (when 
unchecked.)

• Lock Selected Measures Into One System. Click this option if you want Finale to place all 
the selected measures into the same line of music (system).

Both of these options work by placing the selected measures into locked configurations. When 
the measures are locked, a lock icon ç will appear next to the system.See the VIEW MENU 
for more information about displaying or hiding these non-printing lock icons. (For more on 
measure groups, see Installation & Tutorials.)

• Remove System Locks. Click this option to remove all locked measures for the selected sys-
tems. This will allow Finale to move measures to different systems when updating your lay-
out.

• Change: Whole Document • Measure ___ thru ___. Click on the Whole Document radio 
button to lock every system in the score. Click on Measure ___ thru ___ to lock only the mea-
sures entered in the text boxes.

• OK • Cancel. Click OK (or press enter) to confirm, or Cancel to discard, your measure-layout 
settings and return to the score. If you clicked OK, Finale performs the measure-layout action 
and automatically chooses Update Layout from the Edit Menu. If you are displaying System 
Locks, you’re changed systems will now display them. See VIEW MENU.

To undo measure groups you’ve created in this way, choose Update Layout from the Edit 
Menu while pressing shift or press U in the Mass Mover Tool after selecting individual sys-
tems. See MASS MOVER TOOL and UPDATE LAYOUT OPTIONS DIALOG BOX for more details.



Move Layers dialog box 27-58      

OC

OC

ndex

Index

ext 
hapter

ext 
hapter

revious
hapter

revious
hapter
T

T

I

N
C

N
C

P
C

P
C

Move Layers dialog box
How to get there

Click the Mass Mover Tool l, and select a region of measures. Choose Move Layers from the 

Mass Mover Menu.

What it does
The Move Layers command provides a way to move music from one layer to another. You can 
even swap the music between layers—if, for example, you mistakenly entered several stems-down 
notes in Layer 1, which you intended to use only for stems-up (upper) voices.

• Move Contents of Layer [#] into: Layer 1 • Layer 2 • Layer 3 • Layer 4. Using these con-
trols, you can specify how you want to move the selected music among the four transparent 
staff layers. Select the first two checkboxes, for example, and set up the drop-down lists as 
shown above, to swap the contents of Layers 1 and 2.

Be careful, however. If there’s already music in the layer you choose from the drop-down lists, 
it will be replaced by the music you’re transferring. (Finale will warn you if you’re about to 
lose music that’s already in the destination layer.)

Note: If you set up these controls so that the contents of more than one layer get moved into 
the same other layer, Finale will only move the highest-numbered layer’s contents. For exam-
ple, if you indicate that you want the contents of Layers 2, 3, and 4 moved into Layer 1, only 
Layer 4’s music will actually be moved.

• OK • Cancel. Click OK (or press enter) to make the transfer and return to the score. Click 
Cancel to tell Finale to leave the layers as they were. You return to the score.


	Chapter 27: Mass Mover Tool
	Mass Mover Tool
	What it does
	Special mouse clicks and keyboard shortcuts
	Metatools
	To program a Transposition Metatool
	To use a Mass Mover Metatool

	Mass Mover Menu
	How to get there
	What it does

	Copy Measures dialog box
	How to get there
	What it does

	Entry Items dialog box
	How to get there
	What it does

	Entry Modifications dialog box
	How to get there
	What it does

	Measure Items dialog box
	How to get there
	What it does

	Copy Positioning dialog box
	How to get there
	What it does

	Copy Measure Width dialog box
	How to get there
	What it does

	Cut Measures and Cut Music dialog boxes
	How to get there
	What it does

	Items to Clip dialog box
	How to get there
	What it does

	Measure layout
	To move a measure to the previous (or next) system
	To force selected measures into one system
	To specify a number of measures per system
	To remove measure groups through the end of the piece
	To remove measure groups for individual systems
	To create a system break
	To split a measure across a line break

	Clear Items dialog box
	How to get there
	What it does

	Erasing
	To erase everything from a selected region
	To erase a note, rest, or chord
	To erase a note from a chord
	To erase selected elements from a selected region

	SmartFind and Paint dialog box
	How to get there
	What it does

	Apply Articulation dialog box
	How to get there
	What it does

	Change Articulation Assignments dialog box
	How to get there
	What it does

	Change Chord Assignments dialog box
	How to get there
	What it does

	Change Note Expression Assignment dialog box
	How to get there
	What it does

	Change Ties dialog box
	How to get there
	What it does

	Change Note Durations dialog box
	How to get there
	What it does

	Augmentation
	To double the rhythmic values in a passage

	Diminution
	To halve the rhythmic values in a passage

	Change Noteheads dialog box
	How to get there
	What it does

	Change Note Size dialog box
	How to get there
	What it does

	Elapsed Time dialog box
	How to get there
	What it does

	Elapsed time
	To learn the real-time length of selected music

	Explode Music dialog box
	How to get there
	What it does

	Exploding music
	To explode music onto several staves

	Implode Music dialog box
	How to get there
	What it does

	Imploding music
	To implode music onto a single staff

	Piano reductions
	To create a piano reduction for the entire piece
	To create a piano reduction over a region

	Transposition dialog box
	How to get there
	What it does

	Transposing: by interval
	To transpose a region

	Transposing: changing key
	To transpose a piece (Key Signature Tool)
	To transpose chord symbols
	To enter pre-transposed music onto a transposing staff (step time)

	Interval dialog box
	How to get there
	What it does

	Rebar Options dialog box
	How to get there
	What it does

	Rebarring music
	To rebar existing music manually

	Rebeam to Time Signature dialog box
	How to get there
	What it does

	Rebeam to Lyrics dialog box
	How to get there
	What it does

	Retranscription
	To retranscribe a region

	Fit Music dialog box
	How to get there
	What it does

	Move Layers dialog box
	How to get there
	What it does



